Quantum™ Control Software
Quantum Elite Control Software
Quantum Connect Control Software
Conventions Used in this Guide

In this user guide, the following are used:

**NOTE:** A note draws attention to important information.

**TIP:** A tip provides a suggestion to make working with the application easier.

**CAUTION:** A caution indicates a potential hazard to equipment or data.

Commands are written in the fonts shown here:

`^AR` Merge Scene,,Op1 scene 1,1 `^B` 51 `^W` C

`[01]R0004000300040000080000600[02]35[17][03]`

`[Esc][c1][c13][c20][c20][c21]CE←`

**NOTE:** For commands and examples of computer or device responses mentioned in this guide, the character “0” is used for the number zero and “O” represents the capital letter “o.”

Computer responses and directory paths that do not have variables are written in the font shown here:

Reply from 208.132.180.48: bytes=32 times=2ms TTL=32

C:\Program Files\Extron

Variables are written in slanted form as shown here:

`ping xxx.xxx.xxx.xxx –t`

`SOH R Data STX Command ETB ETX`

Selectable items, such as menu names, menu options, buttons, tabs, and field names are written in the font shown here:

From the **File** menu, select **New**.

Click the **OK** button.

Copyright
© 2011 Extron Electronics. All rights reserved.

Trademarks
All trademarks mentioned in this guide are the properties of their respective owners.
Contents

Introduction ............................................................ 1
About this Guide ................................................ 1
Overview of the Quantum Control Software ...... 1
Features ................................................................. 2

Installation and Operation .................................. 3
Requirements ...................................................... 3
System Requirements ...................................... 3
Network Requirements ...................................... 4
Image Processing Hardware ......................... 4
Software Installation ........................................ 5
Configuring the Hardware ................................ 5
Connecting to a Quantum Elite or Quantum Connect ........................................ 5
Configuring the IP Address of the Computer ... 6
Using the Quantum Control Software ................. 8
Running and Exiting the Quantum Control Software .......... 8
Main Application Window ................................ 9
Starting a New Presentation ......................... 10
Loading an Existing Presentation ............. 11
Saving a Presentation ........................................ 11
Using the Auto-Backup Function ..................... 12

System Configuration ............................................. 13
Choosing a Display Processor ...................... 13
Assigning a Name to a Quantum Processor ... 14
Layout Configuration ....................................... 14
Choosing a Display Layout ................. 14
Designing a New Layout ......................... 17
Modifying an Existing Layout .......... 18
Importing a Layout ........................................ 18
Deleting a Layout ............................................. 18
Arranging Layouts ........................................... 19
Restoring Default Layouts ...................... 19
Communications Setup ................................... 19
Serial Ports .................................................... 20
XML Device Drivers ........................................ 21
Setting Up Sources ............................................. 21
Creating Quantum Source Types and Source Definitions ........................................ 22
Deleting Source Definitions ...................... 23
Source Parameters ........................................... 24

Creating a Presentation ....................................... 37
Working with Scenes ........................................... 37
Creating a New Scene ......................................... 38
Copying an Existing Scene ...................... 38
Deleting a Scene .............................................. 39
Changing Scene Properties ..................... 39
Scene Commands ........................................... 40
Changing the Order of Scenes and Scene Navigation ........................................ 41
Working with Windows ................................. 42
Adding More Windows to the Palette .......... 43
Adding a Window to a Scene and Choosing the Window Source ........................................ 44
Removing a Window from a Scene .......... 45
Moving and Resizing a Window ................ 45
Choosing the Window Style ...................... 47
Changing Zoom Properties .................... 50
Changing the Layer of a Window .......... 52
Changing the Virtual Display Properties .. 53

Viewing a Presentation ........................................... 56
Using the Scene Control ................................... 56
Run View and Design View ................. 56
Full Screen Mode ......................................... 57
Creating a Default Layout ...................... 58
Customizing the Layout ......................... 58
Using the Bitmap Manager ..................... 62
Using Auto Play .............................................. 63
Changing the Order of Scenes ................. 64
Changing the Display Time for a Scene .... 64
Starting and Stopping the Presentation .... 64
Changing the Playback Speed .................. 65
Introduction

This section gives an overview of the guide and features of the Quantum™ Elite Control Software and Quantum Connect Control Software. Topics that are covered include:

- **About this Guide**
- **Overview of the Quantum Control Software**

**About this Guide**

This guide provides detailed information about the Quantum Elite Control Software and Quantum Connect Control Software, including software installation and configuration. This guide also details how these applications control the Quantum Elite and Quantum Connect videowall processors.

The features and functionality described in this guide are based on using version 1.60s of the applications with Quantum Elite and Quantum Connect firmware version 7.12 and later.

For the latest details on firmware and software, visit [www.extron.com](http://www.extron.com).

Within this guide, the term “Quantum Control Software” refers to both the Quantum Elite Control Software and Quantum Connect Control Software. The term “Quantum processor” refers to both the Quantum Elite and Quantum Connect videowall processors. Notes distinguish where features differ between the Quantum Elite Control Software, Quantum Connect Control Software, Quantum Elite processor, and Quantum Connect processor.

**Overview of the Quantum Control Software**

Quantum Elite Control Software and Quantum Connect Control Software are Microsoft® Windows®-based applications that are used to control the Quantum Elite and Quantum Connect videowall processors. These products form part of the Extron Quantum offering.

Using the Quantum Control Software, the Quantum Elite and Quantum Connect can display multiple image sources on a single target display or multiple target displays. External analog video sources (such as PAL, NTSC, or SECAM formats) and external analog and digital graphics sources are supported. The Quantum Elite and Quantum Connect also support the use of internal or network-based image files (such as BMP, JPG, GIF, or PNG formats) or RGB computer graphics captured using the QGE 100 Quantum Graphics Encoder.

The feature set supported by the Quantum Elite Control Software differs slightly from the Quantum Connect Control Software. These differences are distinguished in this user guide.

**NOTE:** Quantum Elite Control Software does not operate with a Quantum Connect processor or vice versa.
Features

Features of the Quantum Control Software include:

- The user interface is organized into a series of tasks so that you can easily navigate through them and set up the videowall.
- A virtual canvas provides an on-screen layout for the videowall where windows can be added, sized, and positioned.
- Custom videowall configurations can be saved as window presets for future recall.
- The software lets you create a custom user interface so that the system operator can easily recall the presets.

Scene control

Each source is displayed in a resizable window within the Quantum Control Software, allowing multiple sources to be placed in any position on the display.

The Quantum Control Software uses “scenes” to store different source layouts on the display, including the size, position, and contents of one or more windows. Scenes can be recalled in any order using a customizable user interface or in a predefined order at specific time intervals using the Auto Play function (see “Creating a Presentation” and “Viewing a Presentation”).

Scenes can also be recalled remotely via RS-232 (see “Serial Commands”).
Installation and Operation

This section describes the software installation and communication setup in order to use the Quantum Control Software. The operation of the Quantum Control Software is also described. Topics that are covered include:

- Requirements
- Software Installation
- Configuring the Hardware
- Using the Quantum Control Software

Requirements

System Requirements

To ensure that the Quantum Control Software functions correctly and reliably, it must be installed on a computer that meets or exceeds the following criteria:

<table>
<thead>
<tr>
<th></th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Windows NT4 (SP6)</td>
<td>Windows 2000, Windows XP or Windows 7 (32-bit or 64-bit)</td>
</tr>
<tr>
<td>Processor Speed</td>
<td>200 MHz</td>
<td>450 MHz or higher</td>
</tr>
<tr>
<td>Memory (RAM)</td>
<td>64 MB</td>
<td>128 MB or higher</td>
</tr>
<tr>
<td>Hard Disk Free Space</td>
<td>30 MB</td>
<td>More than 30 MB</td>
</tr>
<tr>
<td>Graphics</td>
<td>1024x768, 65K colors (16-bit)</td>
<td>1024x768, 16.7M colors (32-bit)</td>
</tr>
<tr>
<td>Network Card (Ethernet)</td>
<td>10BASE-T</td>
<td>100BASE-T</td>
</tr>
</tbody>
</table>
Network Requirements

The Quantum Elite and Quantum Connect use specific network ports for communication. Ensure that these ports are accessible.

**Quantum Elite**

The Quantum Elite uses the following port numbers:

<table>
<thead>
<tr>
<th>Port Number</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>1237</td>
<td>Quantum discovery (UDP)</td>
</tr>
<tr>
<td>7004</td>
<td>System configuration (TCP)</td>
</tr>
<tr>
<td>7005</td>
<td>Scene control (TCP)</td>
</tr>
<tr>
<td>7006</td>
<td>System events (TCP)</td>
</tr>
<tr>
<td>5000</td>
<td>Multicast reception of QGE 100 data stream (UDP)</td>
</tr>
<tr>
<td>37533</td>
<td>QGE 100 discovery (UDP)</td>
</tr>
<tr>
<td>37532</td>
<td>Reception of QGE 100 data stream (TCP)</td>
</tr>
</tbody>
</table>

**Quantum Connect**

The Quantum Connect uses the following port numbers:

<table>
<thead>
<tr>
<th>Port Number</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>1238</td>
<td>Quantum discovery (UDP)</td>
</tr>
<tr>
<td>7007</td>
<td>System configuration (TCP)</td>
</tr>
<tr>
<td>7008</td>
<td>Scene control (TCP)</td>
</tr>
<tr>
<td>7006</td>
<td>System events (TCP)</td>
</tr>
</tbody>
</table>

**Image Processing Hardware**

The Quantum Control Software is used in conjunction with a Quantum Elite or Quantum Connect videowall processor.

Quantum Elite hardware comprises of a 4U or 6U card frame into which various input and output cards are installed.

**NOTE:** The Quantum Connect is available as a 4U frame.

See the *Quantum User Guide* for more information about the Quantum Elite and Quantum Connect, including connector pinouts and processing capability.

Except for defining an IP address, it is not necessary to perform any setup procedures on the Quantum Elite or Quantum Connect. System configuration is achieved through the Quantum Control Software.
Software Installation

To install the Quantum Control Software from the Extron Videowall Processing disc:

1. Insert the Extron Videowall Processing disc into the appropriate CD or DVD disk drive of your PC.
2. From the Windows desktop, open **My Computer** and select the appropriate disk drive.
3. Open the Quantum Connect or the Quantum Elite folder, depending on your device.
4. Open the Quantum Connect Software subfolder (for the Quantum Connect) or the Quantum Elite Software subfolder (for the Quantum Elite).
5. Run the Quantum Connect_Setupvx.xxx.exe file (for the Quantum Connect) or the Quantum Elite_Setupvx.xxx.exe file (for the Quantum Elite).
6. Follow the remaining system prompts to complete the installation.

Configuring the Hardware

Connecting to a Quantum Elite or Quantum Connect

The computer with the installed Quantum Control Software communicates with a Quantum Elite or Quantum Connect via Ethernet. This can either be a direct or indirect connection as shown in **figure 1**. Connection to a single videowall processor can use either method, but multiple videowall processors must use the indirect method (for example, via a hub).

A direct connection uses a single cable that is connected between the network port of the computer and the Quantum Elite or Quantum Connect (see **figure 1a**). You must use a crossover cable. A straight-through cable does not work. The network port on the computer must be capable of supporting a 10BASE-T connection as required by the Quantum Elite and Quantum Connect.

An indirect connection is made via a hub, switch or local area network, using a straight-through cable (see **figure 1b**). A crossover cable does not work. The hub or switch connected to the computer must be capable of supporting a 10BASE-T connection as required by the Quantum Elite and Quantum Connect.

Extron recommends using only CAT 5 shielded twisted pair cables. A 16-foot crossover cable is supplied with the Quantum Elite and Quantum Connect processors.

See the *Quantum User Guide* for further details on cable requirements and connector pinouts.
Figure 1. Methods of Connecting the Quantum Elite Control Software Computer to a Quantum Elite Processor

Configuring the IP Address of the Computer

The network port on the computer must be configured to use the same communications protocol as the Quantum Elite or Quantum Connect, which is TCP/IP. The computer must also be allocated an IP address on the same subnet as the Quantum Elite or Quantum Connect (see "IP Addressing").

If the computer is already connected to (and configured for) an existing network, consult the network administrator before making any changes. In addition, you need to be logged on with administrative rights before you can change Windows network settings.
Setting the computer IP address

To set the IP address using Windows XP and Windows 2000:

1. Click the Windows Start button, right-click the My Network Places icon and select Properties from the drop-down menu. The Network Connections window opens.
   - or -

   For Windows 2000:

   Right-click the My Network Places icon on the desktop and select Properties from the drop-down menu. The Network & Dial-up Connections window opens.

2. Right-click the Local Area Connection icon and select Properties from the drop-down menu. The Local Area Connection Properties dialog box opens.


4. Click Use the following IP address and enter the required IP address and subnet mask (see “IP Addressing”).

   NOTE: If preferred, you can change the IP address of the Quantum Elite or Quantum Connect to suit that of the computer.

5. Click OK to execute the changes or click Cancel to retain the existing settings.

6. Restart the computer for the changes to become effective.

To set the IP address using Windows NT:

1. Right-click the Network Neighborhood icon on the Windows desktop and select Properties from the drop-down menu. The Network dialog box opens.

2. Select the Protocols tab.


4. Select the IP Address tab.

5. Click Specify an IP Address and enter the required IP address and subnet mask (see “IP Addressing”).

   NOTE: If preferred, you can change the IP address of the Quantum Elite or Quantum Connect to suit that of the computer.

6. Click OK to execute the changes or click Cancel to retain the existing settings.

7. Restart the computer for the changes to become effective.
**Testing the Ethernet link**

To test the operation of the Ethernet link between the computer and the Quantum Connect or Quantum Elite, you can use the Ping utility.

1. From the desktop, click **Start > Run**. The Run dialog box opens.

2. In the Run dialog box, type the following command:
   
   ```
   ping xxx.xxx.xxx.xxx -t
   ```
   
   where `xxx.xxx.xxx.xxx` is the IP address of the Quantum Elite or Quantum Connect that you want to test.

3. Click **OK** or press the `<Enter>` key on your keyboard. A text box opens showing a series of messages, which are explained below.

4. To stop the ping utility, press `<Ctrl + C>` on your keyboard.

When you run the Ping utility, it displays a series of response messages, which you can use to determine the state of the communications link.

- For example, if you send a ping command to a Quantum Elite or Quantum Connect with the address 208.132.180.48, you should get a message similar to the following:
  
  ```
  Reply from 208.132.180.48: bytes=32 times=2ms TTL=32
  ```
  
  This is the correct response which indicates that the device at the specified address is communicating directly. The response time value may vary according to network traffic.

- If you get the following message:
  
  ```
  Request timed out.
  ```
  
  this indicates that there has been no response from the specified address. Either the videowall processor is not receiving data from the computer or not sending data back. Check that the Quantum Elite or Quantum Connect is powered up and set to the same address to which you sent the ping command. Also, check that you are using the correct type of connecting cables (straight-through or crossover) and that they are not damaged or faulty.

- If you get the following message:
  
  ```
  Reply from 208.132.180.48: Destination host unreachable.
  ```
  
  this indicates that the IP address of the computer is not in the same class as that of the Quantum Elite or Quantum Connect (see "**IP Addressing**").

**Using the Quantum Control Software**

**Running and Exiting the Quantum Control Software**

You can run the Quantum Control Software using any of the following methods:

- Double-click the **Quantum Elite** or **Quantum Connect** icon on the desktop.

- From the desktop, click **Start > All Programs > Extron Electronics > Quantum Elite** (or **Quantum Connect**).

- Double-click a presentation file (file name has a .ctp extension) in Windows Explorer.

If the Access Control feature has been enabled, a Login dialog box is displayed. You need to select an appropriate role and enter a password (see "**Access Control**")

The Quantum Control Software splash screen appears for a few seconds followed by the main application window (see "**Main Application Window**").
You can exit the Quantum Control Software using any of the following methods:

- From the File menu, select Exit.
- Click the button at the top right corner of the application window.
- Double-click the icon in the top left corner of the application window, or single-click the same icon and select Close from the drop-down menu.

If you have not saved your presentation, a message is displayed asking whether you want to save any changes.

**Main Application Window**

The Quantum Control Software application window comprises of the following elements (see figure 2):

- Title bar
- Menu bar
- Toolbars
- Taskbar
- Workspace
- Status bar

![Figure 2. Elements of the Main Application Window](image-url)
Title bar — Shows the name of the currently loaded presentation

Menu bar — Provides a selection of drop-down menus to access various functions in the Quantum Control Software. Most of the menu functions can also be performed by buttons on the toolbars. The available menus change according to which task is currently selected in the taskbar.

Toolbars — The various toolbars within the Quantum Control Software allow quick access to the most commonly used functions within the currently selected task. Most of these functions can also be performed using the menu bar. To hide or show a toolbar for the current task, open the View menu and select the desired toolbar. A check mark beside the menu option denotes that the toolbar is open in the application. You can also click and drag open toolbars to rearrange them in the application window.

Taskbar — Each major task within the Quantum Control Software is represented by an icon in the taskbar. To select a task, click the appropriate button. This displays the workspace, menus, and toolbars associated with the selected task.

The standard set of tasks includes (fewer tasks may be displayed depending on security settings):
- Choose Display Processors
- Choose Layout
- Communications Setup
- Set Up Sources
- Scene Design
- Scene Control
- Remote Access Setup

Workspace — Each task in the taskbar has its own workspace. The workspace contains the controls and functionality needed to complete the task.

Status bar — Shows information about the current status of the Quantum Control Software. From the View menu, select Status Bar to hide or show the status bar.

**Starting a New Presentation**

When you run the Quantum Control Software for the first time after installation, a new untitled presentation is created with no system configuration settings.

Thereafter, there are two methods of starting a new untitled presentation depending on whether you want to:
- Retain the existing system configuration (for example, to make a new presentation for the same system).
- Create a completely new presentation with no system configuration (for example, to make a new presentation for a different system).

To give your untitled presentation a name, you need to save it as described in “Saving a Presentation.”
To retain the existing system configuration, choose one of the following methods:

- Click the button on the main toolbar.
- From the File menu, select New.
- Press <Ctrl + N> on the keyboard.

To create a completely new presentation:

1. Exit the Quantum Control Software by following the instructions in “Running and Exiting the Quantum Control Software.”
2. While holding down the <Shift> key on the keyboard, run the Quantum Control Software by following the instructions in “Running and Exiting the Quantum Control Software.” When the Quantum Control Software screen opens, release the <Shift> key.

See “System Configuration” if you are creating a presentation for a new system or need to make changes to the existing configuration.

See “Creating a Presentation” for information about placing sources on the target display.

**Loading an Existing Presentation**

1. Click the button on the main toolbar.
   - or -
   From the File menu, select Open.
   - or -
   Press <Ctrl + O> on the keyboard.

   The Open dialog box appears.

2. Locate the file to be loaded and click Open.

**Saving a Presentation**

To save the current presentation, click the button on the main toolbar. You can also select Save from the File menu or press <Ctrl + S> on the keyboard.

If the presentation has not been saved previously (it is untitled), the Save As dialog box opens, allowing you to specify a name.

To save a copy of a presentation:

1. From the File menu, select Save As. The Save As dialog box opens.
2. In the File Name field, enter an appropriate name for the presentation. A .ctp extension is automatically appended to the file name.
3. Click Save to save the file.

When creating a presentation, save your work regularly. You can also have the Quantum Control Software automatically create backup files at regular intervals (see “Using the Auto-Backup Function”).
Using the Auto-Backup Function

The Quantum Control Software can automatically back up your presentation at specific intervals. In the event that any changes are lost before saving (such as due to a power outage), you may be able to limit the amount of work you lost by restoring the last auto-backup file.

Setting the backup timer

1. From the Backup menu, select Setup Backup Timer. The Backup Setup dialog box opens.

   ![Backup Setup Dialog Box](image)

   **Figure 3. Backup Setup Dialog Box**

2. Ensure that the Disable Backup check box is cleared to enable auto-backup.

   **NOTE:** If you do not want to use auto-backup, ensure that the Disable Backup check box is selected.

3. In the Hours and Minutes fields, enter the desired values to set the desired interval between each backup.

4. In the Backup Folder field, enter the full path of the Windows folder where the backup files are to be saved. By default, these are saved in the Quantum Elite or Quantum Connect folder.
   - or -
   In the Backup Folder field, click Browse to navigate to the folder where the files are to be saved.

5. Click OK.

Restoring an auto-backup file

1. From the Backup menu, select Restore. If you made changes to the current file, you are prompted to save the file first.

2. In the Save prompt, click Yes to save the current file. The Save As dialog box opens if it is an untitled file.
   - or -
   Click No to exit the current file without saving.

   The Open dialog box is displayed.

   **NOTE:** Backup files are contained within folders according to the date they were created. The files are named with the presentation title and the time they were created.

3. Double-click the folder for the desired date to open it.

4. Select the backup file that you want to restore and click Open.
System Configuration

This section describes the four procedures or tasks associated with configuring the Quantum Control Software to work correctly with a Quantum Elite or Quantum Connect videowall processor. Topics that are covered include:

- Choosing a Display Processor
- Layout Configuration
- Communications Setup
- Setting Up Sources

The tasks described in this section can be completed in any order but the order in which they are listed above is recommended. Unless otherwise stated, all configuration settings described in this section are saved in the presentation (.ctp) file.

Choosing a Display Processor

Before the Quantum Control Software can control a Quantum Elite or Quantum Connect, it must be detected and connected using the Choose Display Processors task.

**NOTE:** Quantum Connect does not support the use of multiple processors.

1. Click the **Choose Display Processors** button in the taskbar.

The Choose Display Processors workspace opens.

![Choose Display Processors](image)

**Figure 4.** Choosing Display Processors
2. Click the button on the toolbar.  
   - or -  
   From the Detect menu, select Detect.

   The Quantum Control Software polls for any Quantum processors accessible via its Ethernet port. An information panel is displayed for each processor detected, as shown in figure 4.

3. To connect to a Quantum processor, select the Connect check box in the row of the appropriate processor. If you are using more than one processor, you need to connect to each processor in the same manner.

   **NOTE:** If the check box does not stay selected, this indicates that the Quantum Control Software is unable to establish or maintain a connection (for instance, due to a faulty cable or the Quantum processor and PC not being on the same IP subnet).

You can disconnect from a Quantum processor by clearing the Connect check box for the appropriate processor.

**Assigning a Name to a Quantum Processor**

If you are using the Quantum Control Software to control more than one processor, you can give a name to each processor that easily identifies its role within the system. This is especially useful when assigning processors to the target display screens.

For example, if you are using two processors driving the left and right sides of the target display array, you can name the two processors Left and Right, respectively.

To assign a name, enter a suitable name in the Name field for the appropriate processor.

**Layout Configuration**

**Choosing a Display Layout**

The target display can be a single screen or several screens interlocked to form a larger display area. Therefore, you need to define the layout within the Quantum Control Software.

The selected layout appears as the virtual display in the Scene Design task (see “Creating a Presentation”). This allows you to place sources exactly where you want them to appear on the actual display array.

Use the Choose Layout task to choose and configure the display layout.
To choose and configure a layout:

1. Click the **Choose Layout** button on the taskbar. The Choose Layout workspace opens.

![Choose Layout Workspace](image1)

**Figure 5. Choose Layout Workspace**

2. From the display layout diagrams, select the layout that matches the arrangement of your target display screens. The currently selected layout is highlighted with a light gray background and red outline.

**TIP:** See "Designing a New Layout" or "Modifying an Existing Layout" if the default layouts do not match your particular display configuration.

3. Right-click a screen (usually starting with the top left screen) in the chosen layout and select **Change Screen Processor IP** from the drop-down list. The following dialog box opens:

![Set Options Dialog Box](image2)

**Figure 6. Set Options Dialog Box**
4. From the Processor IP drop-down list, select the IP address of the processor you are using. The Processor IP drop-down list displays all processors currently connected to the Quantum Control Software via the Choose Display Processors task. If no processors are listed, connect to one as described in “Choosing a Display Processor.”

5. The Available Outputs drop-down list displays currently unassigned output cards (by slot number). Select one to assign to this screen.

NOTE: There are two output channels on each output card and selecting from the Available Outputs list assigns the primary output (channel 1) to the screen. The secondary output (channel 2) is assigned automatically using the Second Output setting (see figure 7 for examples).

6. In the Second Output section, select how the secondary output should be assigned. Choose from:
   - **Horizontal** — The secondary output is assigned to the screen immediately to the right of the primary output (when viewed from the front of the display).
   - **Vertical** — The secondary output is assigned to the screen immediately below the primary output.
   - **Do not Assign** — The secondary output is not assigned; only the primary output is used.
7. Click **OK** to confirm the assignments.

**NOTE:** Screens that have been assigned or mapped appear with a green background in the layout diagram. Unassigned screens have a gray background.

8. Repeat steps 3 through 7 for remaining screens in the layout.

**Designing a New Layout**

If the desired target display layout is not one of the options available by default, you can create rectangular layouts as follows:

1. From the **Layouts** menu select **New**. The New Wall Layout dialog box opens.

![New Wall Layout Dialog Box](image)

**Figure 8.** New Wall Layout Dialog Box

2. In the **Name** field, enter a name or brief description for the layout.

3. In the Wall layout section, set the overall horizontal and vertical size of the target display (measured in whole screens) by clicking the **Left and Right Arrows** in the **Columns** field and the **Up and Down Arrows** in the **Rows** field. Alternatively, you can enter the desired values in the **Columns** and **Rows** fields.

4. From the **Output Mode** drop-down list, select the desired resolution of each screen.

**NOTE:** This sets the correct screen mapping used to determine grid snaps and source window scaling.

5. To enable mullion compensation, select the **Mullion Adjustment** radio button in the Mullion/Edge Blending Compensation section. Mullion is the area of frame border that exists between two displays. This area must be taken into account so that when an image is spread across two or more displays, the image flow is not distorted.

6. If you are using projectors that support soft edge blending, select the **Edge Blend Compensation** radio button and set the amount of overlap required by using the controls in the Mullion/Edge Blending Compensation section.

**NOTE:** The Quantum Elite compensates for the edge blend area but does not adjust the brightness in the area.
7. Select the **Link** check box to link the Horizontal and Vertical adjustment values. When the check box is selected, the **Vertical** field is grayed out and equals the Horizontal value.
   - or -
   If you clear the **Link** check box, you can enter separate values for the horizontal and vertical adjustment.

8. Click **OK** to save the new layout.

**NOTE:** The Quantum Connect does not support the use of edge blended displays.

**Modifying an Existing Layout**

1. Right-click a screen in the chosen layout and select **Edit Wall Layout** from the drop-down list. The Wall Layout Properties dialog opens.
2. Edit the various settings as needed (see “Designing a New Layout”).
3. Click **OK** to save the layout.

**Importing a Layout**

You can import display layouts from another Quantum Control Software file (with a .ctp file extension) as follows:

1. From the **Layouts** menu, select **Import**. The Import Wall Layout dialog opens.
2. Locate the file that contains the desired layout and click **Open**.

**NOTE:** This imports all layouts from the selected file that are not already in the existing file. You can delete any unwanted layouts as described in “Deleting a Layout.”

**Deleting a Layout**

You can delete any of the display layouts that appear in the Choose Layout workspace.

**NOTE:** You cannot undo this operation.

To delete a layout:

1. Click on the layout to be deleted.
2. From the **Layouts** menu, select **Delete**.
Arranging Layouts

You can change the way layouts are presented in the Choose Layout workspace. This can be helpful if there are a large number of layouts and you want to be able to see them more easily.

To arrange layouts:

1. From the View menu, select Arrange Layouts. The Arrange Layouts dialog box opens.

![Arrange Layouts Dialog Box](image)

2. In the Columns field, click the Up and Down Arrows or enter a value to set the number of icon columns to be displayed.

3. In the Panel Size field, click the Up and Down Arrows or enter a value to set the relative panel size for the display layout.

4. Click OK.

Restoring Default Layouts

You can restore the default layouts that were present when you first installed the Quantum Control Software. Performing this operation deletes any user-defined layouts.

To restore a default layout:

From the Layouts menu, select Default.

Communications Setup

Ensure that the serial ports of the computer are correctly configured if:

- You are using the Quantum Control Software to control external devices such as source switchers.
- or -
- You wish to remotely control the Quantum System using serial data strings.
To open the Communications Setup workspace:

Click the **Communications Setup** button on the taskbar.

The Communications Setup workspace opens.

![Communications Setup Workspace](image)

**Figure 10. Communications Setup Workspace**

The left side of the Communications Setup workspace contains a Devices tree, similar to Windows Explorer. There are two main folders:

- **Serial Devices** — Lists any serial device drivers that are currently loaded. Alternatively, if no device drivers are found, any available serial (COM) ports detected by the Quantum Control Software are listed.

- **Settings** — Allows XML device drivers to be enabled or disabled for serial or Ethernet control (see “XML Device Drivers”)

The details displayed in the main area of the workspace change according to the type of item selected in the device tree.

**Serial Ports**

Any unused serial ports (serial ports not used by a device driver) are listed in the Serial Devices folder. These can be configured manually as follows:

1. Select the appropriate port number (such as COM1 or COM3) in the Serial Devices folder of the Devices tree. The Port Settings and Serial Commands sections appear in the workspace.

2. In the Port Settings section, adjust the various parameters as required.

3. In the Serial Commands section, choose whether the port is to be used for incoming (input) or outgoing (output) data, by selecting the appropriate check box.

**NOTE:** Only one port can be used for input data and only one for output data. The Current Ports section shows which ports are currently in use. You can use the same port for both input and output data.
**XML Device Drivers**

Device drivers are defined by an XML file, located in the following folder on the hard disk of the computer:

- `C:\Program Files\Extron\Quantum Elite\XML\Device Drivers` for the Quantum Elite Control Software.
- or -
- `C:\Program Files\Extron\Quantum Connect\XML\Device Drivers` for the Quantum Connect Control Software.

Contact the Extron S3 Sales & Technical Support Hotline for further advice on creating an XML device driver file.

To enable XML device drivers:

1. In the Settings folder of the Devices tree, click **XML Driver Path**. An **Enable XML Device Drivers** check box appears on the right side of the workspace.
2. Select the **Enable XML Device Drivers** check box to load the device drivers. A dialog box opens while the Quantum Control Software loads the drivers. Then, the driver names appear in the Ethernet Devices and Serial Devices folders of the Devices tree.

**Setting Up Sources**

Each source that you need to use in a presentation must have a corresponding source definition within the Quantum Control Software.

A source definition contains full details of the source, such as its signal format (NTSC, PAL, RGB, DVI, and so on) and to which input channel on the Quantum processor the source is connected.

If you are using an external source switcher (such as to give access to multiple sources on one input), the source definition can also include a serial command string used to operate the switcher. A separate source definition is required for each of the sources that can be connected to the Quantum processor.

**NOTE:** You need to set up communications with a switcher before you can define any sources selected via the switcher (see “Communications Setup”).

When the Quantum Control Software needs to display a particular source, it uses the parameters in the source definition to configure the appropriate input channel for the source.

Source definitions are created and set up using the Set Up Sources task.

**NOTE:** The Quantum Connect Control Software does not support the use of GQE 100, Clock, and picture source types.
To view the Set Up Sources Task:

Click the Set Up Sources button on the taskbar.
The Set Up Sources workspace opens.

![Set Up Sources Workspace](image)

**Figure 11. Set Up Sources Workspace**

The source explorer, on the left side of the Set Up Sources workspace, shows a list of source types supported by the Quantum processor. Source definitions are listed under the relevant source type.

The information is displayed as a tree that expands up to three levels as shown in *figure 11*.

When you open the source explorer after creating an entirely new presentation (or for the first time after installation), there are no source definitions listed.

**Creating Quantum Source Types and Source Definitions**

1. Within the source explorer of the Set Up Sources workspace, right-click Display Processors and select the desired option. Available options include:
   - **Create Quantum Sources** — This operation adds a list of the supported source types to the source tree. Then, you need to create source definitions.
   - **Detect Sources** — Selecting this option is the easiest method to create source types. For correct operation, you need to have a Quantum processor connected to the PC with the installed Quantum Control Software. The Quantum Control Software communicates with the Quantum processor and automatically detects the number and type of input cards that are present. The source type list is built automatically. If sources are connected to the processor, the source definitions are created automatically.
   - **Update Sources** — Selecting this option when connected to a Quantum processor updates the source tree details.
2. Right-click the appropriate source type heading in the source explorer (such as RGB, QGE 100, Video, and so on) and select Create New Source from the drop-down menu. An empty source definition screen opens in the workspace (see figure 11 for an example of a new video definition).

3. In the Source Name field, enter a name for the source.

4. If a serial string is required for the source (for instance, to operate an external switcher), enter the appropriate control string in the Source Selected TX field.

5. In the Parameters section, enter the required settings for the source. These settings vary according to the source type and are detailed in “Source Parameters.”

The following dialog opens if you click Detect Sources within a source definition.

![Figure 12. Quantum Source Selection Dialog Box](image)

Select a source from the list and click OK to create a source definition for it.

**Deleting Source Definitions**

To delete a single source definition:

1. Right-click the appropriate source definition in the source explorer and select Delete Source from the drop-down menu.

2. In the Delete Source dialog box, click Yes to confirm the deletion.

To delete all source definitions:

Right-click Display Processors in the source explorer and select Remove All Devices from the drop-down menu.
Source Parameters

The following describes source parameters for each Quantum source type, along with a description of functionality and available options. These parameters are displayed in the Set Up Sources workspace when you select a source definition in the source explorer (see figure 11).

Source parameters — Video

Use the Video source type to view a video source connected to a Quantum Video Input Card.

![Figure 13. Video Source Parameters](image)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Parameter Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Name</td>
<td>&lt;Enter name for source&gt;</td>
<td>Descriptor to identify the source</td>
</tr>
<tr>
<td>Source Type</td>
<td>&lt;Read-only field&gt;</td>
<td>Displays the type of source</td>
</tr>
<tr>
<td>Source Selected TX</td>
<td>&lt;Enter RS-232 string to be transmitted to a connected matrix switcher&gt;</td>
<td>This is optional. Transmits an RS-232 command to a matrix switcher.</td>
</tr>
<tr>
<td>ID</td>
<td>&lt;Enter source input number&gt;</td>
<td>Displays the source input number on the Quantum identified by the card slot number and card input number.</td>
</tr>
<tr>
<td></td>
<td>&lt;Automatically detect source input number&gt;</td>
<td>To detect this value, use the Detect Sources button (see “Creating Quantum Source Types and Source Definitions”). For example, 5.3 is the source connected to input 3 of the card in slot 5.</td>
</tr>
<tr>
<td>Location</td>
<td>&lt;Enter IP address&gt;</td>
<td>Displays the IP address of the Quantum card frame where the source is connected.</td>
</tr>
<tr>
<td></td>
<td>&lt;Automatically detect IP address&gt;</td>
<td>To detect the IP address, use the Detect Sources button (see “Creating Quantum Source Types and Source Definitions”).</td>
</tr>
<tr>
<td>Parameter</td>
<td>Parameter Value</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Format       | • <Read-only field>  
• <Select an option from the drop-down list of format types> | This parameter depends on the AutoDetect setting.  
• If AutoDetect is set to **True**, this parameter is read-only, showing the current source format as detected by the Quantum processor.  
• If AutoDetect is set to **False**, you can select an available source format. |
| AutoDetect   | • **True**:  
  Allows Quantum processor to automatically detect current source type  
• **False**:  
  Allows you to manually select the source type from the **Format** drop-down list. | Sets whether the Quantum processor is to automatically detect the current source type.                                                                                                                                 |
| Deinterlace  | • **1i**:  
  Single Field Interpolation  
• **3i**:  
  Three Field Interpolation | Sets the deinterlace mode to be applied to the source.  
See the *Quantum User Guide* for further information about deinterlacing.                                                                                               |
| Input        | • **Auto**:  
  Automatically discovers the format  
• **SVideo**:  
  Forces S-video mode  
• **Composite**:  
  Forces composite mode | Sets the input format                                                                                                                                                                                   |
| Always On    | • **False** (default):  
  Source is not always on  
• **True**:  
  Source is always on | Sets whether the source is always on                                                                                                                                                                    |
Source parameters — RGB

Use the RGB source type to view an RGB graphics or HD video source connected to a Quantum RGB Input Card.

![Source parameters interface](image)

**Figure 14. RGB Source Parameters**

<table>
<thead>
<tr>
<th>Parameter Group</th>
<th>Parameter</th>
<th>Parameter Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Switch Setting</strong></td>
<td><strong>Source Name</strong></td>
<td>&lt;Enter name for source&gt;</td>
<td>Descriptor to identify the source. This is optional. Transmits an RS-232 command to a matrix switcher.</td>
</tr>
<tr>
<td></td>
<td><strong>Source Selected TX</strong></td>
<td>&lt;Enter RS-232 string to be transmitted to a connected matrix switcher&gt;</td>
<td>Displays the slot and channel number of the RGB card in the Quantum frame. To detect this value, use the Detect Sources button (see “Creating Quantum Source Types and Source Definitions”). For example, 5.3 is the source connected to input 3 of the card in slot 5.</td>
</tr>
<tr>
<td><strong>Source Properties</strong></td>
<td><strong>Source ID</strong></td>
<td>- &lt;Enter source input number&gt; - &lt;Automatically detect source input number&gt;</td>
<td>Displays the IP address of the Quantum card frame where the source is connected. To detect the IP address, use the Detect Sources button (see ”Creating Quantum Source Types and Source Definitions”).</td>
</tr>
<tr>
<td></td>
<td><strong>Source Location</strong></td>
<td>- &lt;Enter IP address&gt; - &lt;Automatically detect IP address&gt;</td>
<td>Displays the IP address of the Quantum card frame where the source is connected. To detect the IP address, use the Detect Sources button (see ”Creating Quantum Source Types and Source Definitions”).</td>
</tr>
<tr>
<td>Parameter Group</td>
<td>Parameter</td>
<td>Parameter Value</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------</td>
<td>--------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Source Format</td>
<td>Format</td>
<td>&lt;Read-only field&gt; &lt;Select an option from the drop-down list of format types&gt;</td>
<td>This parameter depends on the AutoDetect setting. If AutoDetect is selected, this parameter is read-only, showing the current source type as detected by the Quantum processor. If AutoDetect is not selected (radio button is cleared), you can select an available source format.</td>
</tr>
<tr>
<td>Colour Space</td>
<td>Colour Space</td>
<td>RGB (default): Default mode Component HD: Option for component HD inputs Component SD: Option for component SD inputs</td>
<td>Select the required color space.</td>
</tr>
<tr>
<td>Auto Detect</td>
<td>Auto Detect</td>
<td>True (select Auto Detect radio button): Allows Quantum processor to automatically detect the current source type False (select Manual radio button): Allows you to manually select the source type from the Format drop-down list.</td>
<td>Sets whether the Quantum processor is to automatically detect the current source format.</td>
</tr>
<tr>
<td>Manual</td>
<td>Manual</td>
<td>True (select Manual radio button): Allows you to manually select the source type from the Format drop-down list. False (select Auto Detect radio button): Allows Quantum processor to automatically detect the current source type</td>
<td>When this mode is enabled, the input mode can be forced to a known format. In addition, new custom input modes can be built (see “Creating a custom input mode”). Adjusts the brightness and contrast of a source.</td>
</tr>
<tr>
<td>Adjustments</td>
<td>Brightness, Contrast</td>
<td>&lt;Enter values for brightness and contrast&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Phase, Pixel Clock</td>
<td>&lt;Enter values for phase and pixel clock&gt;</td>
<td>Adjusts the sample clock parameters. Ensure that the Auto Phase check box is not selected.</td>
</tr>
<tr>
<td></td>
<td>Auto Phase</td>
<td>&lt;Select Auto Phase check box&gt;: Enables Auto Phase and adjusts clock phase automatically &lt;Clear Auto Phase check box&gt;: Disables Auto Phase</td>
<td>Sets whether to automatically adjust clock phase.</td>
</tr>
<tr>
<td>Parameter Group</td>
<td>Parameter</td>
<td>Parameter Value</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
<td>---------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Source Viewporting</td>
<td>X Pixels, Y Pixels, H pos, V pos</td>
<td>&lt;Enter values for size (X pixels and Y pixels) and position (H pos and V pos)&gt;</td>
<td>These controls allow a section of the captured source to be isolated as a viewport. There is only one viewport for each input channel.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Keep Scene        | Image Auto Centre | • **Off:**  
                      |                                                                                 | No automatic centering                                                                                                                                 |
|                   |             | • **Once:**  
                      |                                                                                 | Centers source image as part of the Detect process                                                                                                                                 |
|                   |             | • **Continuous:**  
                      |                                                                                 | Continually monitors and centers input source                                                                                                                                 |
|                   |             | • **<Select Keep Scene check box>:**  
                      |                                                                                 | Displays the current scene, not the source                                                                                                                                 |
|                   |             | • **<Clear Keep Scene check box>:**  
                      |                                                                                 | Displays source on Quantum output 1.1                                                                                                                                 |
|                   |             |                                                                                 |                                                                                                                                              |
|                   |             |                                                                                 | Sets whether to automatically center the input source image and at what frequency.                                                                                                           |
|                   |             |                                                                                 | Sets whether to displays the current scene or the source.                                                                                                                                         |
Creating a custom input mode

You can create custom input formats for RGB sources in the Set Up Sources workspace.

To do so:

1. Within the source explorer of the Set Up Sources workspace, select an RGB source (or create a new RGB source type and definition as described in "Creating Quantum Source Types and Source Definitions"). The definition screen for the selected source opens in the workspace (see figure 11 for an example).

2. In the Source Format section, select the Manual radio button (see figure 14). This disables Auto Detect mode and lets you choose a known source format.

3. From the Format drop-down list, select the format to use as a starting point.

4. Click New. The User Custom Input Mode dialog box opens.

![User Custom Input Mode Dialog Box](image)

5. In the Mode Name field, enter a name for the custom mode.

6. From the Template Format drop-down list, verify that the desired template is selected for the customized format.

7. From the Colour Space drop-down list, select the color space to use (such as RGB, Component SD, or Component HD).

8. In the Active Area section, adjust the settings as needed by manually entering values into the appropriate fields. Alternatively, click the Up and Down Arrows to adjust the values. You can adjust the following settings:
   - Active Lines
   - Active Pixels
   - Total Pixels
   - First Active Line
   - First Active Pixel
9. In the Signature Parameters section, adjust the settings if needed.

**CAUTION:** Adjust the parameters in the Signature Parameters section, only if absolutely necessary to produce the required image. Changes to these settings may affect the reliability of the Auto Detect feature.

You can adjust the following settings:
- Total Lines
- Line Period
- VSync Lines
- Sync Polarity
- Interlaced

10. Click **Apply** to save the changes and continue making other modifications. Alternatively, click **OK** to save the changes and close the User Custom Input Mode dialog box.

**Editing an input mode**

You can adjust the settings of custom input modes as well as existing factory formats.

**CAUTION:** When adjusting input modes provided with this application, you are making changes to the original factory formats. Any changes made cannot be undone.

To do so:

1. Within the source explorer of the Set Up Sources workspace, select an RGB source (or create a new RGB source type and definition as described in “Creating Quantum Source Types and Source Definitions”). The definition screen for the selected source opens in the workspace.
2. In the Source Format section, ensure the **Manual** radio button is selected.
3. From the **Format** drop-down list, select the format to be modified.
4. Click **Edit**. The User Custom Input Mode dialog box opens.
5. Adjust the settings as necessary.
6. Click **Apply** to save the changes and continue making other modifications. Alternatively, click **OK** to save the changes and close the User Custom Input Mode dialog box.

**Deleting a custom input mode**

To delete a custom format:

1. Within the source explorer of the Set Up Sources workspace, select an RGB source (or create a new RGB source type and definition as described in “Creating Quantum Source Types and Source Definitions”). The definition screen for the selected source opens in the workspace.
2. In the Source Format section, ensure the **Manual** radio button is selected.
3. From the **Format** drop-down list, select the format to be deleted.
4. Click **Delete**. The format is removed from the **Format** drop-down list and the **No Format Set** option is selected.
Source parameters — DVI

Use the DVI source type to view a source connected to a Quantum DVI Video Input Card.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Parameter Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Name</td>
<td>&lt;Enter name for source&gt;</td>
<td>Descriptor to identify the source</td>
</tr>
<tr>
<td>Source Type</td>
<td>&lt;Read-only field&gt;</td>
<td>Displays the type of source</td>
</tr>
<tr>
<td>Source Selected TX</td>
<td>&lt;Enter RS-232 string to be transmitted to a connected matrix switcher&gt;</td>
<td>This is optional. Transmits an RS-232 command to a matrix switcher.</td>
</tr>
<tr>
<td>ID</td>
<td>&lt;Enter source input number&gt;</td>
<td>Displays the source input number on the Quantum identified by the card slot number and card input number. To detect this value, use the Detect Sources button (see “Creating Quantum Source Types and Source Definitions”). For example, 5.2 is the source connected to input 2 of the card in slot 5.</td>
</tr>
<tr>
<td></td>
<td>&lt;Automatically detect source input number&gt;</td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td>&lt;Enter IP address&gt;</td>
<td>Displays the IP address of the Quantum card frame where the source is connected. To detect the IP address, use the Detect Sources button (see “Creating Quantum Source Types and Source Definitions”).</td>
</tr>
<tr>
<td></td>
<td>&lt;Automatically detect IP address&gt;</td>
<td></td>
</tr>
<tr>
<td>Format</td>
<td>&lt;Read-only field&gt;</td>
<td>Reports the source type as detected by the Quantum processor</td>
</tr>
<tr>
<td>Colour Space</td>
<td>● RGB (default): Default mode</td>
<td>Select the required color space.</td>
</tr>
<tr>
<td></td>
<td>● Component SD: Option for component SD inputs</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Component HD: Option for component HD inputs</td>
<td></td>
</tr>
</tbody>
</table>
Source parameters — QGE 100

Use the QGE 100 source type to display a source derived from a QGE 100.

**NOTE:** The Quantum Connect does not support the use of QGE 100 sources.

![Source parameters — QGE 100](image)

**Figure 17. QGE 100 Source Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Parameter Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Name</td>
<td>&lt;Enter name for source&gt;</td>
<td>Descriptor to identify the source</td>
</tr>
<tr>
<td>Source Type</td>
<td>&lt;Read-only field&gt;</td>
<td>Displays the type of source</td>
</tr>
<tr>
<td>Source Selected TX</td>
<td>&lt;Enter RS-232 string to be transmitted to a connected matrix switcher&gt;</td>
<td>This is optional. Transmits an RS-232 command to a matrix switcher.</td>
</tr>
<tr>
<td>Server</td>
<td>&lt;Enter name or IP address of host or source computer&gt;</td>
<td>Specifies the network name* or IP address of the QGE 100 source</td>
</tr>
<tr>
<td></td>
<td></td>
<td>*To use names, the network must support DNS (Dynamic Name Services).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, to select a QGE 100 source called “QGE100” with an IP address of 178.28.229.101, enter either QGE100 or 172.28.229.101.</td>
</tr>
<tr>
<td>IPAddress</td>
<td>&lt;Enter IP address&gt;</td>
<td>Displays the IP address of the QGE 100 where the source is connected.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This field must be left blank if the adapter is using DHCP.</td>
</tr>
<tr>
<td>Multicast Address</td>
<td>&lt;Enter multicast address of the connected QGE 100&gt;</td>
<td>If the source is a QGE 100 operating in Multicast mode, enter its multicast address here. For example, enter 234.5.6.183.</td>
</tr>
<tr>
<td>Multicast Port</td>
<td>&lt;Enter multicast port number of the connected QGE 100&gt;</td>
<td>The default port is 5000.</td>
</tr>
</tbody>
</table>
**Source parameters — Picture**

Use the Picture source type to display an image file (in JPG, GIF, PNG, or BMP format). The file can be located on the Quantum processor hard drive (in the `d:/pictures` folder) or elsewhere on the network.

**NOTE:** The Quantum Connect does not support the use of Picture sources.

---

**Figure 18. Picture Source Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Parameter Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Name</td>
<td><code>&lt;Enter name for source&gt;</code></td>
<td>Descriptor to identify the source</td>
</tr>
<tr>
<td>Source Type</td>
<td><code>&lt;Read-only field&gt;</code></td>
<td>Displays the type of source</td>
</tr>
<tr>
<td>Source Selected TX</td>
<td><code>&lt;Enter RS-232 string to be transmitted to a connected matrix switcher&gt;</code></td>
<td>This is optional. Transmits an RS-232 command to a matrix switcher.</td>
</tr>
<tr>
<td>Filename</td>
<td><code>&lt;Enter path and filename of the desired image&gt;</code></td>
<td>Indicates the path and filename of the desired image.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● To select a file on the Quantum processor, use the format:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>d:/pictures/companylogo.jpg</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>● To select a file on a network computer or server, use the format:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>\imageserver\companylogo.jpg</code></td>
</tr>
<tr>
<td>Location</td>
<td>● <code>&lt;Enter IP address&gt;</code></td>
<td>Displays the IP address of the Quantum card frame where the image file is located.</td>
</tr>
<tr>
<td></td>
<td>● <code>&lt;Automatically detect IP address&gt;</code></td>
<td>To detect the IP address, use the <strong>Detect Sources</strong> button (see &quot;Creating Quantum Source Types and Source Definitions&quot;).</td>
</tr>
</tbody>
</table>
Parameter | Parameter Value | Description |
--- | --- | --- |
GraphicsOverlay | **True**: Makes the specified key color in the image transparent  
**False**: Disables transparency (key color is opaque) | Sets whether to make the specified key color transparent |
KeyColour | <Enter three values from 0 to 255> |  
If GraphicsOverlay parameter is set to **True**:  
These values set the color in the image that will be transparent  
If Graphics Overlay parameter is set to **False**: These values set the red, green, and blue levels.  
For example:  
- 255,255,255 = White  
- 0,0,0 = Black  
- 0, 0, 255 = Blue |

**Source parameters — Timer**

Use the Timer source type to create an on-screen clock or count-down or count-up timer.

**NOTE:** The Quantum Connect does not support the use of Clock or Timer sources.

![Figure 19. Timer Source Parameters](image-url)

**Figure 19. Timer Source Parameters**
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Parameter Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Name</td>
<td>&lt;Enter name for source&gt;</td>
<td>Descriptor to identify the source</td>
</tr>
<tr>
<td>Source Type</td>
<td>&lt;Read-only field&gt;</td>
<td>Displays the type of source</td>
</tr>
<tr>
<td>Source Selected TX</td>
<td>&lt;Enter RS-232 string to be transmitted to a connected matrix switcher&gt;</td>
<td>This is optional. Transmits an RS-232 command to a matrix switcher.</td>
</tr>
<tr>
<td>ID</td>
<td>&lt;Enter an alphanumeric label&gt;</td>
<td>User-defined alphanumeric label (such as the source name) that is unique to the show</td>
</tr>
<tr>
<td>GraphicsOverlay</td>
<td>• True: Makes the specified background color in the image transparent</td>
<td>Sets whether to make the background color of the image transparent</td>
</tr>
<tr>
<td></td>
<td>• False: Disables transparency (background color is opaque)</td>
<td></td>
</tr>
<tr>
<td>Size</td>
<td>• Small</td>
<td>Sets the size of text on the clock or timer display</td>
</tr>
<tr>
<td></td>
<td>• Medium (default)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Large</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Extra Large</td>
<td></td>
</tr>
<tr>
<td>ForeColour</td>
<td>&lt;Enter three values from 0 to 255&gt;</td>
<td>Sets the foreground (text) color for the clock or timer display. These values set the red, green, and blue levels. For example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BackColour</td>
<td>&lt;Enter three values from 0 to 255&gt;</td>
<td>Sets the background color for the clock or timer display. These values set the red, green, and blue levels. For example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Font</td>
<td>• Arial</td>
<td>Sets the font for the clock or timer display</td>
</tr>
<tr>
<td></td>
<td>• Verdana (default)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Microsoft Sans Serif</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Tahoma</td>
<td></td>
</tr>
<tr>
<td>TimeFormat</td>
<td>• 12: Sets 12-hour time format</td>
<td>Sets the time format for the clock or timer display</td>
</tr>
<tr>
<td></td>
<td>• 24 (default): Sets 24-hour time format</td>
<td></td>
</tr>
<tr>
<td>ShowSeconds</td>
<td>• True: Displays hours, minutes, and seconds</td>
<td>Sets whether to display seconds in the time</td>
</tr>
<tr>
<td></td>
<td>• False: Displays only hours and minutes</td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>Parameter Value</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ShowDate</td>
<td>● <strong>True:</strong> Displays the date and time</td>
<td>Sets whether to display the date along with the time</td>
</tr>
<tr>
<td></td>
<td>● <strong>False:</strong> Displays only the time</td>
<td></td>
</tr>
<tr>
<td>DateFormat</td>
<td>● <code>dd/mm/yyyy</code> (default)</td>
<td>Sets the format to use when displaying the date</td>
</tr>
<tr>
<td></td>
<td>● <code>mm/dd/yyyy</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● <code>20 June 2006</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● <code>June 20 2006</code></td>
<td></td>
</tr>
<tr>
<td>ShowWeekDay</td>
<td>● <strong>True:</strong> Displays the day of the week (Monday to Sunday) and the date</td>
<td>Sets whether to display the day of the week along with the date</td>
</tr>
<tr>
<td></td>
<td>● <strong>False:</strong> Displays only the date</td>
<td></td>
</tr>
<tr>
<td>TimerStartTime</td>
<td><code>&lt;Enter the time from which the timer begins&gt;</code></td>
<td>When operating in Timer mode, this value defines the start time in <code>hh:mm:ss</code>. The default is <code>00:00:00</code>. In countdown mode, when the timer reaches zero, the timer reloads with the preset value and starts again.</td>
</tr>
<tr>
<td>ClockMode</td>
<td>● <strong>Clock</strong> (default)</td>
<td>Sets whether the display shows a standard clock or a timer. For Timer mode, set the TimerCountDirection parameter as needed.</td>
</tr>
<tr>
<td></td>
<td>● <strong>Timer</strong></td>
<td></td>
</tr>
<tr>
<td>TimeZone</td>
<td><code>&lt;Select an option from the drop-down list of time zones&gt;</code></td>
<td>Sets the time zone to use for the clock and date</td>
</tr>
<tr>
<td>Alignment</td>
<td>● <strong>Left</strong></td>
<td>Sets the horizontal alignment of the display, relative to the window in which it is placed.</td>
</tr>
<tr>
<td></td>
<td>● <strong>Center</strong> (default)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● <strong>Right</strong></td>
<td></td>
</tr>
<tr>
<td>TimerCountDirection</td>
<td>● <strong>Up</strong> (default)</td>
<td>When using Timer mode, use this parameter to set the direction in which the timer will count.</td>
</tr>
<tr>
<td></td>
<td>● <strong>Down</strong></td>
<td></td>
</tr>
</tbody>
</table>
Creating a Presentation

This section describes the Scene Design task and creating a presentation using scenes and windows. Topics that are covered include:

- Working with Scenes
- Working with Windows

Working with Scenes

To view a source on the target display, place a window (containing the appropriate source) on the display. Windows and scenes are created and edited in the Scene Design task.

You can store the size, position, and contents of one or more windows as a scene. Each scene can have a different arrangement of windows and sources.

NOTE: The number of windows allowed within a scene depends on the Quantum processor hardware. The maximum is 128 windows per output card. See the Quantum User Guide for more details.

To open the Scene Design task:

Click the Scene Design button on the taskbar.

The Scene Design Workspace opens.

Figure 20. Main Features and Toolbars of the Scene Design Task
Creating a New Scene

New scenes are added to the end of the scene list. A new scene has the same window palette (see “Working with Windows”) as the currently selected scene. No other attributes are copied from the selected scene.

To create a new scene:

1. Click the button on the Scene Properties toolbar. The Scene Properties dialog opens.

2. Modify the default scene title as desired. To change other settings follow the procedure described in “Changing Scene Properties.”

3. Click OK. In the Scene Control workspace, a new Scene Selection button is also added for the new scene (see “Using the Scene Control”).

4. Add a window to the scene (see “Adding a Window to a Scene and Choosing a Window Source”).

Copying an Existing Scene

You can create an exact copy of any scene that exists in your presentation. This is useful when creating a number of scenes that only have slight variations from each other.

The copied scene is inserted immediately after the original scene. It has the same window palette, window layout, control commands, and Auto Play settings as the original scene.

To copy an existing scene:

1. In the scene list of the Scene Design workspace, select the name of the scene to be copied.

2. Click the button on the Scene Properties toolbar. The Scene Properties dialog box opens for the copied scene (see figure 21).

3. Modify the default scene title and other settings as needed.

4. Click OK. In the Scene Control workspace, a new Scene Selection button is also added for the copied scene (see “Using the Scene Control”).
Deleting a Scene

1. In the scene list of the Scene Design workspace, select the scene to be deleted. The selected scene is displayed in the workspace.

2. Click the button on the Scene Properties toolbar. In the Scene Control, the corresponding Scene Selection button is also deleted (see “Using the Scene Control”).

Changing Scene Properties

1. Select a scene in the scene list of the Scene Design workspace and click the button on the Scene Properties toolbar.  
   - or -  
   For any scene, right-click the scene title in the scene list.  
   The Scene Properties dialog box (see figure 21) opens.

2. Modify the settings as needed.  
   These settings include:
   - **AutoPlay Delay (mSec)** — Set the amount of time that the scene is displayed during Auto Play (see “Changing the Display Time for a Scene”).
   - **Include Scene in Autoplay** — Select this check box to include this scene in an Autoplay presentation. Clear this check box to exclude the scene (see “Changing the Display Time for a Scene”).
   - **Don’t display windows - send serial strings only** — By selecting the Don’t display windows check box on the Scene Properties dialog, only the serial strings (if any) associated with the string are executed. Any source or layout changes in the scene are ignored. This allows the scene to transmit a serial command without changing the current layout of the target display, such as to operate an external source switcher.

3. Click **OK**.

**NOTE:** Any changes that are made to the scene title do not automatically update the button text that is located in the Scene Control workspace (see “Changing the properties of a button”).
**Scene Commands**

**Adding a scene command**

1. Select a scene in the scene list of the Scene Design workspace and click the button on the Scene Properties toolbar.
   - or -
   For any scene, right-click the scene title in the scene list.
   The Scene Properties dialog box (see figure 21) opens.

2. Select the appropriate **Scene Commands** tab. The available tabs include:
   - **Pre Scene Commands** — Commands that occur as soon as the scene is selected but not yet fully displayed
   - **Post Scene Commands** — Commands that occur when the scene display is fully complete
   - **Exit Scene Commands** — Commands that occur when another scene is selected but before the pre-scene commands of the new scene

   **NOTE:** The procedure to add, edit, or remove commands from each tab is the same.

3. Click **Add** to display the Add Command dialog box.

   ![Add Command Dialog Box](image)

   **Figure 22. Add Command Dialog Box**

4. From the **Device** drop-down list, select the device for which you want to add a command.

5. In the **Commands** section, select the desired command name from the list. If you select a non-XML defined serial port (which is listed as **output**), a text box is displayed for you to enter a free format text string.

6. Click **OK** to add the command to the scene.
Changing the order of scene commands

1. Select a scene in the scene list of the Scene Design workspace and click the button on the Scene Properties toolbar.
   - or -
   For any scene, right-click the scene title in the scene list.
   The Scene Properties dialog (see figure 21) opens.
2. Select the appropriate Scene Commands tab.
3. In the command list, select the command to be moved.
4. In the Command Ordering section, click the Move Up or Move Down button to move the command to the desired position in the list.

Removing a scene command

1. Select a scene in the scene list of the Scene Design workspace and click the button on the Scene Properties toolbar.
   - or -
   For any scene, right-click the scene title in the scene list.
   The Scene Properties dialog (see figure 21) opens.
2. Select the appropriate Scene Commands tab.
3. In the command list, select the command to be removed.
4. Click Remove.

Editing a serial (output) scene command

1. Select a scene in the scene list of the Scene Design workspace and click the button on the Scene Properties toolbar.
   - or -
   For any scene, right-click the scene title in the scene list.
   The Scene Properties dialog (see figure 21) opens.
2. Select the appropriate Scene Commands tab.
3. In the command list, select the output name.
4. Click Edit.
5. Edit the free format text string as needed.
6. Click OK.

Changing the Order of Scenes and Scene Navigation

You can change the order of the scenes in the scene list. When using the Auto Play option, scenes are recalled in the order that they appear in this list.

To move a scene in the scene list:
   Drag and drop the scene title to a new position in the scene list.
You can use the Scene Control toolbar, scene list, and keyboard to navigate to the scene you want to view or edit.

<table>
<thead>
<tr>
<th>To go to...</th>
<th>Click...</th>
</tr>
</thead>
<tbody>
<tr>
<td>a specific scene</td>
<td>the scene title in the scene list.</td>
</tr>
<tr>
<td>the next scene</td>
<td>the button or press the &lt;Down Arrow&gt; key on the keyboard.</td>
</tr>
<tr>
<td>the previous scene</td>
<td>the button or press the &lt;Up Arrow&gt; key on the keyboard.</td>
</tr>
<tr>
<td>the first scene</td>
<td>the button or press the &lt;Home&gt; key on the keyboard.</td>
</tr>
<tr>
<td>the last scene</td>
<td>the button or press the &lt;End&gt; key on the keyboard.</td>
</tr>
</tbody>
</table>

**Working with Windows**

In the Scene Design workspace, the actual target display is represented by the virtual display area and each window that can be placed on the display is represented by a virtual window.

Each virtual window has a unique number (automatically assigned by the Quantum Control Software) and a user-definable label that is typically used to identify the source.

![Virtual Window with Label](image)

**Figure 23. Virtual Window with Label**

When you create a new presentation, nine virtual windows are docked in the window palette (see figure 20).

**NOTE:** You can add more windows if required (see ”Adding More Windows to the Palette”), but after they are added, they cannot be deleted.

The contents of each window can be the same or different between scenes. Initially, each window has a dark gray background indicating no source is selected for the window. As you create new scenes, the contents of each window in the palette are copied from the windows of the currently selected scene.
To use a window within a scene, click and drag the window from the window palette into the virtual display area. The appearance of the window in the window palette changes depending on whether it is docked (not used in the scene) or undocked (used in the scene).

![Docked and Undocked Windows in the Window Palette](image)

**Figure 24. Docked and Undocked Windows in the Window Palette**

### Adding More Windows to the Palette

**NOTE:** Windows cannot be deleted from the window palette.

When you hover over a window in the palette, a popup opens showing the window number and its source type. For example:

![Window Details Popup](image)

**Figure 25. Window Details Popup**

To add a window to the palette:

- Right-click anywhere in the window palette and select Add Window from the drop-down menu. A new window is added to the window palette with a default color wash and is given the next available window number.

- You can also right-click in the virtual display or workspace (but not in an existing window) and select Add Window from the drop-down menu. A new window is added to the window palette and appears in the workspace area.
Adding a Window to a Scene and Choosing the Window Source

To add a window to a scene:
1. Select a docked window in the window palette to be added to the current scene. It is indicated with a red outline.

2. Click the button on the Window Properties toolbar.
   - or -
   Drag the window into the virtual display area.
   - or -
   Press the <Delete> key on your keyboard.

3. Modify the window as desired (see “Choosing the Window Style”).

To choose a window source:
1. Select a window in the window palette or a window in the virtual display area of the currently selected scene.
2. Right-click the selected window and select Window Source from the drop-down menu. The Quantum Sources dialog opens.

![Quantum Sources Dialog Box](image)

**Figure 26. Quantum Sources Dialog Box**

3. In the Sources section of the Quantum Sources dialog, select the desired source. You can filter the listed sources by selecting an option from the View By or Category drop-down lists. You can also search for sources using the Search field.

   **NOTE:** The Search field is case-sensitive.

   See “Setting Up Sources” for information about changing source parameters.

4. Click OK.
Removing a Window from a Scene

1. In the window palette or in the virtual display area, select the undocked window to be removed from the currently selected scene.

2. Click the button on the Window Properties toolbar.
   - or -
   Drag the window into the window palette.
   - or -
   Press the <Delete> key on your keyboard.

Moving and Resizing a Window

To move or resize a window using the virtual display area:

1. Select a window in the virtual display area or select an undocked window in the window palette of the currently selected scene. In the virtual display area, the window is highlighted as shown below:

   ![Figure 27. Selecting a Window](image)

2. Move and resize the window as needed.

   To resize the window, position the mouse point over one of the resizing handles and drag the window border to the desired position. The mouse pointer changes to a double arrow symbol, showing which direction the border can be moved.

   To move the window, position the mouse pointer within the window and drag the window to a new location. The mouse pointer changes to a crossed arrow symbol.

   To size the window to fit the entire display array, right-click the window and select Full Screen from the drop-down menu.

   With the layout grid turned on, window borders automatically align or snap to the grid lines. You can temporarily disable this feature by holding down the <Shift> key on your keyboard while moving or resizing the window.

   If necessary, you can hide the layout grid or change its spacing (see “Changing the Virtual Display Properties”).
Using the Window Size & Position dialog

If you need to position or resize a window with pixel accuracy, you can use the Window Size & Position dialog.

1. Right-click a window in the virtual display area of the currently selected scene and select Adjust Position and Size from the drop-down menu. The Window Size & Position dialog opens.

![Window Size & Position Dialog Box](image)

2. Set the Variable aspect ratio check box as needed.
   - Cleared — The vertical and horizontal sizes are locked together. The viewport maintains the aspect ratio of the original source.
   - Selected — The vertical and horizontal size can be adjusted independently.

3. Click the Position Arrows to adjust the window position or enter pixel values in the X (left edge) and Y (top edge) fields.

4. Click the Width and Height Arrows to adjust the overall window size or enter pixel values in the W (width) and H (height) fields.

5. To set the actual source element to a specific size (rather than the overall window size), click the Size Arrows to make the necessary adjustments. Width and height values in the Source Window Size section show the size of the source, allowing for the width of any border or title text (see figure 29).

![Example of Window Sizing](image)

6. Click Apply to update the display with the new settings and leave the dialog box open. Click OK to save the new settings and close the dialog or click Cancel to keep the existing settings.
Choosing the Window Style

**NOTE:** The Quantum Connect Control Software does not support the use of window styles.

Each window can be given a text label to identify the source on the target display and can be given a colored border if desired.

Two types of text labels can be applied to a window:
- **Overlay text** — Text is placed over the source.
- **Title text** — Text is placed above or below the source on a colored background.

The appearance of window text and borders is defined by a style. A style determines the font, size, color and position of text, as well as border width and color.

**Figure 30** shows examples of different window styles.

Window styles are defined in an XML file called ESQuantumConfig.xml. To change or add to the default styles provided in this version of the Quantum Control Software, you need to edit the parameters of this file.

By default, if a style that adds a border or title text is applied to a window, the overall window size does not increase. The window source is scaled down to allow the border or title text to fit within the same overall window size.

If you need the source to remain a specific size, you need to manually set it to the required size using the Window Position dialog. See “Moving and Resizing a Window” for more information.
Figure 30. Examples of Different Window Styles

Window with Source Only

Window with Overlay Text
You can change the Overlay Text font, size, and color. Text can be aligned vertically (top, middle, or bottom) and horizontally (left, middle, or right).

Window with Border

Window with Title Text
You can change the Title Text font, size, and color. Background color is defined by the border color. Text can be aligned vertically (top or bottom) and horizontally (left, middle, or right).

Window with Border and Title Text
Changing the window style and window text

To change the window style:

1. In the window palette or in the virtual display area of the currently selected scene, select a window.

2. Right-click the window and select **Window Properties** from the drop-down menu.
   - or -
   From the **Window** menu, select **Window Properties**.
   The Set Window Properties dialog opens.

3. Select the **Window Styles** tab and choose a style from the Styles list:

![Set Window Properties dialog](Image)

**Figure 31. Window Styles Tab**

The Title Text Preview and Overlay Text Preview sections of this tab show the appearance of text for the selected style.

**NOTE:** The style called “None” is a plain source window with no border or title text.
To change the window text:

1. In the window palette or in the virtual display area of the currently selected scene, select a window.
2. Right-click the window and select **Window Properties** from the drop-down menu.
   - or -
   From the **Window** menu, select **Window Properties**.
   The Set Window Properties dialog opens.
3. Select the **Window Text** tab and enter the desired text in the **Title Text** and **Overlay Text** fields.

![Set Window Properties dialog](image)

**Figure 32.** Window Text Tab

**NOTE:** If the **Title Text** field is empty, the source name is displayed as title text. If the **Overlay Text** field is empty, no overlay text is displayed.

**Changing Zoom Properties**

By default, a window that contains a source displays the entire source frame. The source is automatically scaled to fit within the window. However, if needed, you can zoom into any part of the source frame, such as to exclude unwanted or irrelevant material from the source.

The portion of the image that you can zoom into is called a viewport (see **figure 33a**). A viewport can:

- Be as small as 6 percent of the active source frame.
- Have the same aspect ratio as the source or be stretched in either the horizontal or vertical direction.
- Be positioned (or panned) to view any part of the source frame.

Regardless of the size, shape, or position of the viewport, the portion of the source image that it contains fills the entire window (see **figure 33b**).
The number of viewported windows that can be present within one scene is dependent on source types as well as the size and shape of the windows.

**NOTE:** Zooming in on part of a source only enlarges the image detail that is already present in the source signal. If the image detail is not of good quality, zooming in does not increase the level of detail.

a. An example of a standard viewport that preserves the aspect ratio of the original source:

![Original Source](image1)

![Viewported Source](image2)

b. An example of using a stretched viewport. Note that if the window does not have the same aspect ratio as the original source, the viewported image is compressed or stretched to fit the window. To retain the aspect ratio of the viewport, the window needs to be the same shape as the viewport.

![Original Source](image3)

![Viewported Source](image4)

**Figure 33. Example of Source Viewporting**
To change the viewport:

1. Right-click the window in the virtual display area and select **Zoom Properties** from the drop-down menu. The Source Properties dialog opens.

![Source Properties Dialog Box](image)

**Figure 34.** Source Properties Dialog Box

2. Set the **Variable aspect ratio** check box as needed.
   - **Cleared** — The vertical and horizontal zoom percentages are locked together. The viewport maintains the aspect ratio of the original source.
   - **Selected** — The vertical and horizontal zoom percentages can be adjusted independently.

3. Select fine or coarse adjustment by clicking the appropriate radio button (**Fine** or **Coarse**).

4. Click the **Zoom/Stretch Arrows** to change the size of the viewport.
   - or -
   Click and drag the handles of the viewport area to adjust the size.

To quickly return the Zoom and Stretch settings back to 100 percent (no viewport), click **Reset**.

5. Click the **Pan Arrows** to change the position of the viewport.
   - or -
   Click and drag the viewport area to the desired position.

The target display updates in real time as you make changes to the zoom and pan settings.

6. Click **OK** to accept the new viewport settings or click **Cancel** to retain the previous settings.

### Changing the Layer of a Window

The layer of a window determines whether it appears in front of or behind other windows. Only one window can exist on a layer. A layer is also known as a Z order or priority.

Layers are identified by a number and the higher the number, the further forward the window. For example, a window on layer 3 appears in front of a window on layer 2, but behind a window on layer 4.

To see the current layer number of a window, hover over the window in the window palette. A popup opens showing the window number, its current layer, and source type.

**NOTE:** The maximum number of windows allowed within a scene is dependant on the Quantum processor hardware. The maximum is 128 windows per output card. See the *Quantum User Guide* for more information.
To change the layer:

1. Select a window in the window palette or in the virtual display area of the currently selected scene.

2. Using the Window Properties toolbar, click one of the following buttons to change the layer of the window. You can also use the Window menu to change the layer.

<table>
<thead>
<tr>
<th>Buttons and Menu Options</th>
<th>Window Movement</th>
</tr>
</thead>
<tbody>
<tr>
<td>![button]</td>
<td>Send backward by one layer</td>
</tr>
<tr>
<td>- or -</td>
<td>Bring forward by one layer</td>
</tr>
<tr>
<td>From the Window menu, select Send Back</td>
<td></td>
</tr>
<tr>
<td>- or -</td>
<td>Send to the back of all layers (such as layer 1)</td>
</tr>
<tr>
<td>From the Window menu, select Bring Forward</td>
<td></td>
</tr>
<tr>
<td>- or -</td>
<td>Bring to the front of all layers</td>
</tr>
<tr>
<td>From the Window menu, select Bring to Front</td>
<td></td>
</tr>
</tbody>
</table>

Changing the Virtual Display Properties

Various properties of the virtual display area can be altered based on personal preference or to assist in creating scenes in the Scene Design workspace. Most of these properties can be changed using the Virtual Display Properties toolbar (see figure 20).

Layout grid

The layout grid in the Scene Design workspace assists you in accurately placing windows on the target display. When the grid is visible, the borders of all windows automatically snap to the grid. When the grid is not visible, the snap to grid feature is disabled.

To show the grid:

Click the button.
- or -
From the Grid menu, select Enable Snap Grid. This option is listed when no grid is visible.
To hide the grid:

Click the button.
- or -
From the Grid menu, select Disable Snap Grid. This option is listed when the grid is visible.

**NOTE:** When the grid is hidden, the snap to grid feature is disabled.

To temporarily disable the snap to grid feature:

Hold down the <Shift> key on your keyboard while placing or resizing the window.

You can change the number of vertical and horizontal lines in the layout grid.

To increase the number of grid lines:

Click the button
- or -
Press the <Page Down> key on your keyboard.

To decrease the number of grid lines:

Click the button
- or -
Press the <Page Up> key on your keyboard.

**Virtual display zoom**

You can zoom in on the virtual display area to assist with accurately placing windows or you can zoom out to see more of the target display.

To zoom in on the display:

Click the button.
- or -
From the View menu, select Zoom In.
- or -
Press the <+> key on your keyboard.

To zoom out of the display:

Click the button.
- or -
From the View menu, select Zoom Out.
- or -
Press the <-> key on your keyboard.

**NOTE:** Zooming in on or out of the virtual display does not affect the content of the real display.
**Background Color**

In the virtual display area, you can change the color of the background and the virtual display itself.

**NOTE:** Changing the color of the virtual display has no effect on the content of the real display.

To change the background or virtual display color:

1. Right-click anywhere in the layout area (but not on a window) of the Scene Design workspace and select either *Change Background Color* or *Change Virtual Display Color* from the drop-down menu. The Color dialog opens.

2. Select a predefined or newly defined color.

3. Click **OK**.
Viewing a Presentation

This section describes the Scene Control task and two methods of viewing scenes in a presentation. Topics that are covered include:

- Using the Scene Control
- Using Auto Play

Using the Scene Control

The Scene Control task lets you recall specific scenes in your presentation by clicking a scene control button on the computer screen.

The layout and design of the buttons can be customized to suit the end user.

To access the Scene Control:

Click the Scene Control button on the taskbar. The Scene Control workspace and Views toolbar open.

Run View and Design View

There are two modes for the Scene Control workspace:

- Run View
- Design View

Run View

In Run View mode, the Scene Selection buttons are active. To recall a scene, click the appropriate Scene Selection button.

Here is an example of the Scene Control workspace in Run View:

![Scene Control Workspace in Run View](image)

**Figure 35.** Scene Control Workspace in Run View
Design View

In Design View mode, you can customize the layout and design of the Scene Selection buttons. To assist with button sizing and positioning, a layout grid is displayed.

Here is an example of the Scene Control workspace in Design View:

![Scene Control Workspace in Design View](image)

**Figure 36. Scene Control Workspace in Design View**

To toggle between Run View and Design View, click the button on the Views toolbar.

Full Screen Mode

The Scene Control task can also be operated in full screen mode, in which only the workspace area, containing the Scene Selection buttons, is visible.

When full screen mode is active, the Scene Control automatically switches to Run View and access is disabled to all setup tasks. This mode is useful when the Quantum Control Software is to be controlled via a touch screen.

You can activate full screen mode from the Scene Control task as follows:

1. Click the button on the Views toolbar.

To return to normal screen mode, press the `<Esc>` key on your keyboard.

Starting up in full screen mode

The Quantum Control Software can also open directly to full screen mode at startup. To do this, you need to create a Windows shortcut and specify a “switch” on the command line.

To start the Quantum Control Software in full screen mode:

1. Minimize (or close) the Quantum Control Software and any other Windows applications so that you can see the desktop.
2. Create a new shortcut by right-clicking the desktop and selecting **New > Shortcut** from the drop-down menu. The Create Shortcut dialog box opens.
3. Enter the command line. You can enter the path to the program or locate it by clicking the **Browse** button. In a typical installation, the command line is “C:\Program Files\Extron\Quantum Elite\Quantum Elite.exe” - or - “C:\Program Files\Extron\Quantum Connect\Quantum Connect.exe”
4. Add the characters `-u` to the end of the command line, leaving a space at the end of the program path.
5. Click Next.
6. Enter the name for the shortcut or accept the default name and click Finish.
7. If you want the new shortcut to execute when the operating system starts, you need to copy or move the shortcut to the Windows Startup folder. See the Windows Help system for more information on how to do this.

Creating a Default Layout

You can have the Quantum Control Software create a default layout, comprising of a button for each scene in your presentation. Generally, this function is used to create a new layout and customize the layout as needed.

Any customized settings that you have already created are lost by using this function.

To create a default layout:
1. Ensure that the Scene Control workspace is in Design View (the layout grid is visible).
2. Click the **button on the Views toolbar. A Warning dialog box opens with a reminder that any existing layout settings will be lost if you proceed.
3. In the Warning dialog box, click Yes to create a default layout or click No to retain the existing layout.

Customizing the Layout

**Changing background properties**

You can set the background of the Scene Control workspace to be a solid color or a bitmap image.

To change the background:
1. Ensure that the Scene Control workspace is in Design View (with the layout grid visible).
2. Right-click anywhere on the workspace background (but not on a Scene Selection button). The Background Properties dialog opens.

![Background Properties Dialog Box](image.png)

**Figure 37.** Background Properties Dialog Box
3. Apply a solid color or a bitmap image.
   To apply a solid color:
   a. In the Background Properties dialog, click Colour. The Color dialog opens.
   b. Select a predefined color from the Basic Colors palette or define a custom color.
   c. Click OK. This returns you to the Background Properties dialog.
   d. Click OK in the Background Properties dialog to apply the chosen color.
   - or -
   To apply a bitmap image:
   a. In the Background Properties dialog, click Bitmap Manager. The Bitmap Manager dialog opens.
   b. In the Available Bitmaps list, select an image name. If there are no bitmaps listed or to add a new bitmap, see “Using the Bitmap Manager.”
   c. Click OK. This returns you to the Background Properties dialog.
   d. Click OK in the Background Properties dialog to apply the chosen image.

Moving and resizing a button
1. Ensure that the Scene Control workspace is in Design View (with the layout grid visible).
2. Click a Scene Selection button. It is highlighted with a dotted outline and resizing handles.

![Selecting a Scene Selection Button](image)

**Figure 38. Selecting a Scene Selection Button**

3. Move and resize the button as needed.
   - To resize the button, position the mouse pointer over one of the resizing handles and drag the button border to the desired position. The mouse pointer changes to a double arrow symbol, showing which direction the border can be moved.
   - To move the button, position the mouse pointer within the button and drag the button to a new location. The mouse pointer changes to a crossed arrow symbol.

By default, the button borders snap to the layout grid. You can temporarily disable grid snap by holding down the <Shift> key on your keyboard while moving or resizing the button.
Changing the properties of a button

You can set the button background to be a solid color or bitmap image. You can also change the text displayed on the button, including the font style, size, and color.

To open the Change Button Properties dialog:

1. Ensure that the Scene Control workspace is in Design View (with the layout grid visible).
2. Right-click the Scene Selection button. The Change Button Properties dialog opens.

![Change Button Properties Dialog Box]

**Figure 39.** Change Button Properties Dialog Box

To change the text and font displayed on the button:

1. In the Button Text field of the Change Button Properties dialog, enter the desired text.

   **NOTE:** When the button is first created, the button text is copied from the scene title. Any subsequent change to the scene title does not update the button text.

2. Click Font to change the size, style, or color of the font. The Font dialog opens.
3. Change the font settings as desired.
4. Click OK. This returns you to the Change Button Properties dialog.
5. Click OK to apply the new text and font settings.

To apply a solid color to the button:

1. In the Change Button Properties dialog, click Color. The Color dialog opens.
2. Select a predefined color from the Basic Colors palette or define a custom color.
3. Click OK. This returns you to the Change Button Properties dialog.
4. Click OK to apply the selected color.
To apply a bitmap image to the button:

1. In the Change Button Properties dialog, click **Bitmap Manager**. The Bitmap Manager dialog opens.

2. In the Available Bitmaps list, select an image name. If there are no bitmaps listed or to add a new bitmap, see “**Using the Bitmap Manager**.”

3. Click **OK**. This returns you to the Change Button Properties dialog.

4. Click **OK** to apply the selected image.

### TIPS:
- The edge color of a button is determined by the color applied to the entire button and remains visible when an image is used.
- To improve the appearance of the button, first apply a color to the button that matches the color of the image, then apply the image.

If you need to hide the button during Run View, select the **Hide** check box in the Change Button Properties dialog.

### Changing the properties of multiple buttons

You can change the properties (such as color and font size) of more than one button simultaneously. However, you cannot move or resize several buttons simultaneously.

To simultaneously change the properties of multiple buttons:

1. Ensure that the Scene Control workspace is in Design View (with the layout grid visible).

2. In the workspace, ensure that the mouse pointer is not over a **Scene Selection** button, then click and drag to draw a rectangle around the buttons you want to change. When you release the mouse button, all **Scene Selection** buttons within the rectangle are selected (with resizing handles).

3. Right-click on a button, if you want to copy the properties from that button.
   - or -
   Right-click anywhere else in the workspace, if you want to obtain the default properties.

   The Change Button Properties dialog opens and **Multiple selection** is shown in the preview section.

4. In the Change Button Properties dialog, make the necessary modifications to the font color, font typeface, button color and image.

   **NOTE:** You cannot change the button text when selecting multiple buttons.

5. In the Change Button Properties dialog, click **OK** to apply the new properties to all buttons in the selection.
Using the Bitmap Manager

Clicking **Bitmap Manager** in either the Background Properties dialog or the Change Button Properties dialog opens the Bitmap Manager dialog.

![Bitmap Manager Dialog Box](image)

**Figure 40. Bitmap Manager Dialog Box**

Any bitmaps (.bmp files) that are applied to the buttons or background of the Scene Control workspace are **not** saved with the presentation file. Instead, the files are copied to a separate folder on the hard drive from which the Quantum Control Software accesses them.

**NOTE:** If you copy a presentation from one computer to another, you must remember to copy the bitmaps.

Any missing bitmaps are indicated on the appropriate button or background with a red X on a blue background.

![Missing Bitmap](image)

**Figure 41. Missing Bitmap**

To change the bitmap folder:

1. In the **Bitmap Folder** field of the Bitmap Manager dialog, click **Browse**. The Browse for Folder dialog opens.
2. Select the appropriate folder.
3. Click **OK**.

To select an existing bitmap:

1. In the Available Bitmaps list of the Bitmap Manager dialog, select the appropriate file.
2. Click **OK**.
**Adding, removing, or restoring a bitmap**

To add a new bitmap:

1. In the Bitmap Manager dialog, click **Add Bitmap**. The Open dialog appears.
2. Locate the desired bitmap (.bmp) file.
3. Click **OK**. The bitmap file is copied to the directory specified in the **Bitmap Folder** field and appears in the Available Bitmaps list.

You can also copy files directly to the Bitmap folder using Windows Explorer. However, you need to close the Bitmap Manager dialog and reopen it to update the Available Bitmaps list.

When the Quantum Control Software is first installed, a number of sample background and button bitmaps are copied to the Bitmaps folder. By default, this folder is located in:

C:\Program Files\Extron\Quantum Elite
- or -
C:\Program Files\Extron\Quantum Connect

To remove a bitmap:

1. In the Available Bitmaps list of the Bitmap Manager dialog, select the appropriate file.
2. Click **Remove Bitmap**.

   If the file is currently in use, a Warning dialog box opens asking whether to delete the file. Click **Yes** to proceed.

   The file is deleted from the list and the bitmap folder. If the bitmap was in use by any buttons, the buttons now display a red X on a blue background (see **figure 41**).

To restore a deleted bitmap:

   Follow the instructions for adding a new bitmap (see the steps under “**To add a new bitmap**”). As long as the file name of the restored bitmap is the same as the missing bitmap, the image is restored to the appropriate button or background.

   - or -

   Copy the missing file to the bitmap folder using Windows Explorer. You need to restart the Quantum Control Software to fully restore the bitmap image to the appropriate button or background.

**Using Auto Play**

When using the Auto Play function, the Quantum Control Software displays each scene for a specified period and automatically switches to the next scene. The period of time that a scene is displayed can be different for each scene.

When the presentation starts, it plays continuously until it is stopped. When the last scene is reached, Auto Play continues with the first scene.

To use Auto Play:

   Click the **Scene Design** button on the taskbar to open the Scene Design task.

   The Scene Design workspace opens.

The main features and toolbars associated with the Scene Design workspace are shown in **figure 20**.
Changing the Order of Scenes

In an Auto Play presentation, scenes are recalled in the order that they appear in the scene list of the Scene Design workspace.

To move a scene in the scene list:

1. Drag and drop the scene title to a new position in the list (see “Working with Scenes”).

Changing the Display Time for a Scene

You can choose whether or not a scene is included in an Auto Play presentation and the length of time that it is displayed by using the Scene Properties dialog.

To change the display time:

1. Click the Scene Design button on the taskbar.
   The Scene Design workspace (see figure 20) opens.

2. For the currently selected scene in the scene list, click the button on the Scene toolbar.
   - or -
   For any other scene, right-click a scene title in the scene list.
   The Scene Properties dialog opens. Ensure the Properties tab (see figure 21) is selected.

3. Modify the Auto Play Delay (mSec) setting, the Include Scene in Autoplay setting, and other settings as needed. The value in the Auto Play Delay (mSec) field is the amount of time that the scene is displayed in a presentation. The Include Scene in Autoplay check box, if selected, includes the scene in an Autopay presentation.

4. Click OK.

Starting and Stopping the Presentation

To start the presentation:

1. Click the Scene Design button on the taskbar.
   The Scene Design workspace (see figure 20) opens.

2. Click the button on the Scene Control toolbar. The Autoplay mode dialog box opens while Autopay is active:

   ![Autoplay Mode Dialog Box](image)

   Figure 42. Autoplay Mode Dialog Box
The presentation plays continuously until it is stopped. When the presentation reaches the last scene, Auto Play returns to the first scene.

To stop the presentation:

Click the button on the Scene Control toolbar.

**Changing the Playback Speed**

When using Auto Play, the duration of displaying each scene is controlled by the Auto Play Delay setting in the Scene Properties dialog (see “Changing the Display Time for a Scene”).

However, it is possible to speed up or slow down the rate of display across the entire presentation.

To change the playback speed:

Use the following buttons on the Scene Properties toolbar in the Scene Design task:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Increase Speed" /></td>
<td>Increases playback speed. Each click decreases the normal delay time* of each scene by 10 percent, thus increasing playback speed.</td>
</tr>
<tr>
<td><img src="image" alt="Decrease Speed" /></td>
<td>Decreases the playback speed. Each click increases the normal delay time* of each scene by 10 percent, thus decreasing the playback speed.</td>
</tr>
</tbody>
</table>

*The normal delay time is defined by the Auto Play delay value on the Scene Properties screen.

The current Auto Play time adjustment is displayed on the status bar, with the normal speed being 100 percent. For example:

```
Scene delay = 90.00% of scene setting
```

**Figure 43. Scene Delay Information on Status Bar**
Serial Commands

This section describes the format of the serial data strings that can be transmitted or received by the Quantum Control Software. Topics that are covered include:

- Control of External Devices
- Remote Control of a Presentation
- ASCII Character Chart

Control of External Devices

To enable the control of external devices, the external devices need to be connected to the Data TX output of the computer serial (RS-232) port.

These ports are usually identified as COMx where x is a number from 1 to 4 (such as COM2). You must ensure that the appropriate serial port is configured correctly by following the instructions in “Communications Setup.”

Serial data strings can be included within scenes (see “Scene Commands”). In a scene, three strings can be transmitted:

- **Pre Scene Commands** — Commands that occur as soon as the scene is selected but not yet fully displayed.
- **Post Scene Commands** — Commands that occur when the scene display is fully complete.
- **Exit Scene Commands** — Commands that occur when another scene is selected but before the pre-scene commands of the new scene.

These commands can be used to control external source switchers or other RS-232 controllable devices.
**Format of External Control Strings**

The exact content of the serial data string depends on the device you are controlling. See the device user guide for more information.

A serial data string can comprise of ASCII text, hexadecimal data, and control characters. Pauses can also be inserted as necessary to fine tune the timing of the messages. See the chart below.

<table>
<thead>
<tr>
<th>Data String</th>
<th>Transmitted Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text characters using the computer keyboard.</td>
<td>Text Character</td>
</tr>
<tr>
<td>A caret (^) followed by the control character. For example: ^M effectively sends a “carriage return.” For letters, use only uppercase characters.</td>
<td>Control Character</td>
</tr>
<tr>
<td>The hex pair preceded by a caret (^) and an “at” sign (@). For example: ^@4B^@24 transmits hex 4B and hex 24 (ASCII characters K and $)</td>
<td>Hex Data</td>
</tr>
<tr>
<td>A caret (^) followed by a comma. This delays transmission of subsequent characters in the string by 100 milliseconds. Pauses can be stacked to create longer delays. For example: ^,^,^,^,^, gives a delay of 500 milliseconds (0.5 seconds).</td>
<td>A Pause</td>
</tr>
</tbody>
</table>

**Examples of external control strings**

**Example 1:** AUXB12\^M

This transmits AUXB12 out of the serial port and terminates with a \^M (carriage return).

**Example 2:** \^@C0\^@00\^@02\^@00\^@15\^,\^,\^,\^,\^,\^2!\^C

This transmits the hex characters C0 00 02 00 15, pauses for 300 milliseconds, and then sends the ASCII character 2! followed by a \^C (break).

**NOTES:** Most devices expect some kind of termination character at the end of a control string. \^C (break) or \^M (carriage return) are used most frequently; however, this is dependant on the hardware you are controlling. There is no standard for termination characters.

Any spaces entered within the data string are transmitted just like any other character. You should, therefore, avoid entering or leaving spaces in a data string, unless they are specifically required by the receiving device.
Remote Control of a Presentation

Remote control of a presentation is achieved by sending R-type messages to the Data RX input on one of the serial (RS-232) ports of the computer.

Alternatively, R-type messages can be created as simple ASCII text strings and transmitted using suitable software, such as a terminal emulation program or a control system.

You can use the external control capability of a presentation. See “Control of External Devices” for information about remotely controlling another presentation running on a different computer.

R-type Message Format

The standard R-type message structure is shown below with examples in ASCII format, hexadecimal format, and mixed hex and ASCII format (see the ASCII Character Chart for reference).

A command string is constructed in the following format:

SOH R Data STX Command ETB ETX

Portions of the command string are defined as follows:

- **SOH** (Start of Header) In hex, this is 01. In ASCII, this is ^A.
- **R** This portion of the command string signifies that the message is an R-Type command.
- **Data** This portion consists of the information to be executed. This information is optional and is only required if the specific remote control command requires additional information, such as a show name, to properly execute the command.
- **STX** (Start of Transmission) In hex, this is 02. In ASCII, this is ^B.
- **Command** This portion contains the remote command type.
- **ETB** (End of Block) In hex, this is 17. In ASCII, this is ^W.
- **ETX** (End of Transmission) In hex, this is 03. In ASCII, this is ^C.

The contents of the portions denoted by Data and Command vary according to the required function and can be determined from the command table. Hex portions in a command string are denoted in brackets.

**NOTE:** The spaces between characters are included for clarity only and must not appear in the transmitted message. The only permitted spaces within a string are in scene names.

The following example is a remote control string in ASCII format. This example runs a scene with the name “ATTRACT”:

^A R ATTRACT ^B 07 ^W ^C

The hex version of the above command string is:

[01][52][41][54][54][52][41][43][54][02][30][37][17][03]

A more common approach (compared to creating a string entirely in hex pairs or in ASCII), is to mix hex and ASCII data. This makes the string more readable. The mixed version of the above command string is:

[01] R ATTRACT [02] 07 [17] [03]
Command Symbol Definitions

- **X501** = Scene location in list (1 to 999)
- **X502** = Scene name (ASCII, case-sensitive)
- **X503** = Window number (0000 to 0998, zero-based, leading zeros required)
  
  Example: Window 25 = 0025
- **X504** = Zoom percentage (000 to 999, leading zeros required)
  
  000 = No zoom
  
  500 = Zoom into 50 percent of image
- **X505** = Pan horizontal location (000 to 999, leading zeros required)
  
  000 = Left-most edge of input video
  
  500 = Middle of image horizontally
- **X506** = Pan vertical location (000 to 999, leading zeros required)
  
  000 = Top-most edge of input video
  
  500 = Middle of image vertically
- **X507** = Window horizontal position (-9999 to 99999, leading zeros required)
  
  -0500 = 500 pixels off screen to the left
  
  01920 = 1920 pixels to the right of the left-most edge
- **X508** = Window vertical position (-9999 to 99999, leading zeros required)
  
  -0500 = 500 pixels above the top edge of the screen
  
  01080 = 1080 pixels below the top border
- **X509** = Window horizontal size (00000 to 99999, leading zeros required)
  
  00400 = 400 pixels wide
- **X510** = Window vertical size (00000 to 99999, leading zeros required)
  
  00300 = 300 pixels tall
- **X511** = Input source name (ASCII, case-sensitive)
- **X512** = Window style name (ASCII, case-sensitive)
- **X513** = Border or overlay onscreen text (ASCII, case-sensitive)
- **X514** = Merge scene name (ASCII, case-sensitive)
- **X515** = Window layer number (0 to 999)
- **X516** = File location including the full directory path
  
  Example: C:\Files\TestShow

Command Table

<table>
<thead>
<tr>
<th>Command</th>
<th>ASCII</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recall Scene</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recall by list position</td>
<td>[01] R[X501] [02] 05 [17] [03]</td>
<td>Recalls scene X501 according to the scene list</td>
</tr>
<tr>
<td>Example:</td>
<td>[01] R04 [02] 05 [17] [03]</td>
<td>Recalls the fourth scene in the list in the Scene Design task</td>
</tr>
<tr>
<td>Recall by scene name</td>
<td>[01] R[X502] [02] 07 [17] [03]</td>
<td>Recalls scene X502</td>
</tr>
<tr>
<td>Example:</td>
<td>[01] RPRESET 2 [02] 07 [17] [03]</td>
<td>Recalls scene named “PRESET 2”</td>
</tr>
<tr>
<td>Recall next scene</td>
<td>[01] R [02] 0n [17] [03]</td>
<td>Recalls next scene in the list</td>
</tr>
<tr>
<td>Recall previous scene</td>
<td>[01] R [02] 0p [17] [03]</td>
<td>Recalls previous scene in the list</td>
</tr>
<tr>
<td>Window Source</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select input</td>
<td>[01] R[X511] [02] 36 [17] [03]</td>
<td>Selects input X511 to be shown in window X503</td>
</tr>
<tr>
<td>Example:</td>
<td>[01] R0004Laptop Input [02] 36 [17] [03]</td>
<td>Sets window 5 to display source named “Laptop Input”</td>
</tr>
<tr>
<td>Select input in named scene</td>
<td>[01] R[X502], X503, X511 [02] 52 [17] [03]</td>
<td>Routes input X511 to window X503 in scene X502</td>
</tr>
</tbody>
</table>

**NOTE:** If using merge scenes, X502 needs to be remerged for change to occur.

Autorun Controls

<table>
<thead>
<tr>
<th>Command</th>
<th>ASCII</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begin from 1st scene</td>
<td>[01] R [02] 0= [17] [03]</td>
<td>Begin the autorun sequence with first scene in the list</td>
</tr>
<tr>
<td>Begin from current scene</td>
<td>[01] R [02] 0&gt; [17] [03]</td>
<td>Begin the autorun sequence from currently displayed scene</td>
</tr>
<tr>
<td>Increase autorun speed</td>
<td>[01] R [02] 0+ [17] [03]</td>
<td>Increase the duration by 10 percent for each scene to be displayed</td>
</tr>
<tr>
<td>Decrease autorun speed</td>
<td>[01] R [02] 0- [17] [03]</td>
<td>Decrease the duration by 10 percent for each scene to be displayed</td>
</tr>
<tr>
<td>Stop autorun sequence</td>
<td>[01] R [02] 0&lt; [17] [03]</td>
<td>Halts the autorun sequence</td>
</tr>
<tr>
<td>Command</td>
<td>ASCII</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Window Visibility</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hide Window</td>
<td>[01] RX5030 [02] 33 [17] [03]</td>
<td>Sets window <strong>X503</strong> to be hidden</td>
</tr>
<tr>
<td>Example:</td>
<td>[01] RX00050 [02] 33 [17] [03]</td>
<td>Sets window 6 to be hidden</td>
</tr>
<tr>
<td>Hide Multiple Windows</td>
<td>[01] RX503, RX50, RX50, 0 [02] 63 [17] [03]</td>
<td>Sets window <strong>X503</strong> through <strong>X503</strong> in scene <strong>X503</strong> to be hidden</td>
</tr>
<tr>
<td><strong>NOTE:</strong> If using merge scenes, <strong>X503</strong> needs to be remerged for change to occur.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show Window</td>
<td>[01] RX5031 [02] 33 [17] [03]</td>
<td>Sets window <strong>X503</strong> to be shown</td>
</tr>
<tr>
<td>Example:</td>
<td>[01] RX00051 [02] 33 [17] [03]</td>
<td>Sets window 6 to be shown</td>
</tr>
<tr>
<td>Show Multiple Windows</td>
<td>[01] RX503, RX50, RX50, 1 [02] 63 [17] [03]</td>
<td>Sets window <strong>X503</strong> through <strong>X503</strong> in scene <strong>X503</strong> to be shown</td>
</tr>
<tr>
<td><strong>NOTE:</strong> If using merge scenes, <strong>X503</strong> needs to be remerged for change to occur.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Window Size and Position</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set size and position</td>
<td>[01] RX503[RX07][RX08][RX10] [02] 35 [17] [03]</td>
<td>Sets window <strong>X503</strong> to position (<strong>RX07</strong>, <strong>RX08</strong>) and size <strong>RX08</strong> by <strong>RX10</strong></td>
</tr>
<tr>
<td>Example:</td>
<td>[01] RX0004 0030 0040 0080 0060 [02] 35 [17] [03]</td>
<td>Sets window 5 to position (300, 400) and size 800x600</td>
</tr>
<tr>
<td>Set parameters in named scene</td>
<td>[01] RX503, RX50, RX50, RX50, RX50, RX08 [02] 57 [17] [03]</td>
<td>Sets window <strong>X503</strong> in scene <strong>X502</strong> to position (<strong>RX07</strong>, <strong>RX08</strong>) and size <strong>RX08</strong> by <strong>RX10</strong></td>
</tr>
<tr>
<td><strong>NOTE:</strong> If using merge scenes, <strong>X503</strong> needs to be remerged for change to occur.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Window Priority</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bring window to front</td>
<td>[01] RX503, RX50, 1 [02] 78 [17] [03]</td>
<td>Brings window <strong>X503</strong> to be in front of all windows</td>
</tr>
<tr>
<td>Send window to back</td>
<td>[01] RX503, RX50, 0 [02] 78 [17] [03]</td>
<td>Sends window <strong>X503</strong> behind all windows</td>
</tr>
<tr>
<td>Example:</td>
<td>[01] RX004 0030 0040 0080 0060 [02] 78 [17] [03]</td>
<td>Sets window 5 in scene “PRESET 2” to be in front</td>
</tr>
<tr>
<td>Bring window forward</td>
<td>[01] RX503, RX50, RX51, 1 [02] 79 [17] [03]</td>
<td>Brings window <strong>X503</strong> forward <strong>RX10</strong> layers</td>
</tr>
<tr>
<td>Send window backward</td>
<td>[01] RX503, RX50, RX51, 0 [02] 79 [17] [03]</td>
<td>Sends window <strong>X503</strong> backward <strong>RX10</strong> layers</td>
</tr>
<tr>
<td>Example:</td>
<td>[01] RX004, 3, 0 [02] 79 [17] [03]</td>
<td>Sends window 5 in scene “PRESET 2” backward 3 layers</td>
</tr>
</tbody>
</table>

**NOTE:** **X503** = Scene name (ASCII, case-sensitive)  
**X503** = Window number (0000 to 0998, zero-based, leading zeros required)  
**RX07** = Window horizontal position (-9999 to 99999, leading zeros required)  
**RX08** = Window vertical position (-9999 to 99999, leading zeros required)  
**RX10** = Window horizontal size (00000 to 99999, leading zeros required)  
**RX10** = Window vertical size (00000 to 99999, leading zeros required)  
**RX10** = Window layer number (0 to 999)
<table>
<thead>
<tr>
<th>Command</th>
<th>ASCII</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Zoom and Pan</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set zoom and pan</td>
<td>[01] RX03RX10RX03RX04 [02] 34 [17] [03]</td>
<td>Sets window RX03 to have a zoom of RX04 and pan of RX03 and RX04</td>
</tr>
<tr>
<td>Example 1:</td>
<td>[01] R0004 500 000 000 [02] 34 [17] [03]</td>
<td>Sets window 5 to zoom into 50 percent of the image and to display the top left</td>
</tr>
<tr>
<td>Example 2:</td>
<td>[01] R0004 750 750 750 [02] 34 [17] [03]</td>
<td>Sets window 5 to zoom into 25 percent of the image and to display the bottom right</td>
</tr>
<tr>
<td>Set Parameters in named scene</td>
<td>[01] RX03 RX04 RX03 RX04 RX03 RX04 [02] 58 [17] [03]</td>
<td>Sets window RX03 in scene RX04 to have a zoom of RX04 and a pan of RX03 and RX04</td>
</tr>
</tbody>
</table>

**NOTE:** If using merge scenes, RX03 needs to be remerged for change to occur.

Coordinate system:
The horizontal and vertical pan settings allow you to position the upper left corner of the zoomed region on a 1000 x 1000 grid that represents the original image.

<table>
<thead>
<tr>
<th>Window Style</th>
<th>ASCII</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select style</td>
<td>[01] RX03RX11 [02] 37 [17] [03]</td>
<td>Sets window RX03 to use predefined style RX11</td>
</tr>
<tr>
<td>Example:</td>
<td>[01] R0004 Arial 2 [02] 37 [17] [03]</td>
<td>Sets window 5 to use window style named “Arial 2”</td>
</tr>
<tr>
<td>Select style in named scene</td>
<td>[01] RX03 RX03 RX11 [02] 53 [17] [03]</td>
<td>Sets window RX03 in scene RX04 to use style RX11</td>
</tr>
</tbody>
</table>

**NOTE:** If using merge scenes, RX03 needs to be remerged for change to occur.

<table>
<thead>
<tr>
<th>Define border text</th>
<th>ASCII</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example:</td>
<td>[01] R0004 Auxiliary Input [02] 38 [17] [03]</td>
<td>Sets window 5 to have border text stating “Auxiliary Input”</td>
</tr>
<tr>
<td>Set border text in named scene</td>
<td>[01] RX03 RX03 RX11 [02] 54 [17] [03]</td>
<td>Sets window RX03 in scene RX04 to have border text RX11</td>
</tr>
</tbody>
</table>

**NOTE:** If using merge scenes, RX03 needs to be remerged for change to occur.

**NOTE:**
- RX03 = Scene name (ASCII, case-sensitive)
- RX03 = Window number (0000 to 0998, zero-based, leading zeros required)
- RX04 = Zoom percentage (000 to 999, leading zeros required)
- RX03 = Pan horizontal location (000 to 999, leading zeros required)
- RX03 = Pan vertical location (000 to 999, leading zeros required)
- RX11 = Window style name (ASCII, case-sensitive)
- RX11 = Border or overlay onscreen text (ASCII, case-sensitive)
<table>
<thead>
<tr>
<th>Command</th>
<th>ASCII</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define overlay text</td>
<td>([01] R X50) [X51] [02] 39 [17] [03]</td>
<td>Sets window (X50) to have overlay text stating (X51)</td>
</tr>
<tr>
<td>Example:</td>
<td>([01] R 0004 CONFIDENTIAL [02] 39 [17] [03]</td>
<td>Sets window 5 to have overlay text stating “CONFIDENTIAL”</td>
</tr>
<tr>
<td>Set overlay text in named scene</td>
<td>([01] R X50, X50, X51 [02] 55 [17] [03]</td>
<td>Sets window (X50) in scene (X50) to have overlay text (X51)</td>
</tr>
</tbody>
</table>

**NOTE:** If using merge scenes, \(X50\) needs to be remerged for change to occur.

<table>
<thead>
<tr>
<th>Batch Execute Commands</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Begin command collection</td>
<td>([01] R [02] 41 [17] [03]</td>
</tr>
<tr>
<td>Execute collected commands</td>
<td>([01] R [02] 42 [17] [03]</td>
</tr>
<tr>
<td>Example:</td>
<td>([01] R [02] 41 [17] [03]</td>
</tr>
<tr>
<td></td>
<td>[01] R PRESET 2 [02] 07 [17] [03]</td>
</tr>
<tr>
<td></td>
<td>[01] R004 Laptop Input [02] 36 [17] [03]</td>
</tr>
<tr>
<td></td>
<td>[01] R004 CONFIDENTIAL [02] 38 [17] [03]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Merge Scene Controls</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Create merge scene</td>
<td>([01] R X51, ,1 [02] 51 [17] [03]</td>
</tr>
<tr>
<td>Add or remerge scene</td>
<td>([01] R X51, , X50, 1 [02] 51 [17] [03]</td>
</tr>
<tr>
<td>Delete scene</td>
<td>([01] R X51, , X50, ,1 [02] 51 [17] [03]</td>
</tr>
<tr>
<td>Purge merge scene</td>
<td>([01] R [02] 56 [17] [03]</td>
</tr>
<tr>
<td></td>
<td>([01] R X51, , ,1 [02] 51 [17] [03]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Save Current Show to File</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Save current show</td>
<td>([01] R X51 [02] 11 [17] [03]</td>
</tr>
<tr>
<td>Example:</td>
<td>([01] R C: \Files\TestShow [02] 11 [17] [03]</td>
</tr>
</tbody>
</table>

**NOTE:**
- \(X50\) = Scene name (ASCII, case-sensitive)
- \(X50\) = Window number (0000 to 0998, zero-based, leading zeros required)
- \(X51\) = Border or overlay onscreen text (ASCII, case-sensitive)
- \(X51\) = Merge scene name (ASCII, case-sensitive)
- \(X51\) = File location including the full directory path
Examples of R-type Messages

The following examples of R-type messages assume that there are five scenes in the currently loaded presentation and that they appear in the scene list as:

- Intro
- Video
- Demo
- Conference
- Finish

**NOTE:** The spaces between characters are included for clarity only and must not appear in the transmitted message.

To select the Conference scene by its name:
`^AR Conference ^B 07 ^W ^C`

To select the Demo scene by its position in the scene list:
`^AR 3 ^B 05 ^W ^C`

To select the next scene in the scene list:
`^AR ^B 0n ^W ^C`

To start AutoPlay from the first scene (in this case, the Intro scene):
`^AR ^B 0= ^W ^C`

To stop AutoPlay:
`^AR ^B 0< ^W ^C`

To increase AutoPlay playback speed by 10 percent:
`^AR ^B 0+ ^W ^C`

To hide or show window 7 in the current scene:
`^AR 0006 0 ^B 33 ^W ^C (hides the window)`
`^AR 0006 1 ^B 33 ^W ^C (shows the window)`

To set window 4 to the “Warning” style:
`^AR 0003 Warning ^B 37 ^W ^C`

To set the overlay text of window 4 to read “Incident Reported”:
`^AR 003 Incident Reported ^B 39 ^W ^C`

To set the viewport of window 5 to show a magnified area from the center of the source image:
`^AR 0004 500 250 250 ^B 34 ^W ^C`
Merge scene commands (51-56) provide independent control of areas on a display wall that are driven from a Quantum processor or array of processors. This is useful for installations where more than one operator needs access to the display wall. See “Working with Merge Scenes” for more information about merge scene functions.

A merge scene allows sources on different areas of the display wall to be merged into the overall scene.

To create a merge scene called “Merge Scene”:

^AR Merge Scene,,1 ^B 51 ^W^C

To add a scene called “Op 1 scene 1” in “Merge Scene”:

^AR Merge Scene,,Op1 scene 1,1 ^B 51 ^W^C

**NOTE:** “Op1 scene 1” must already be created in the Quantum Control Software.

To remove the “Op1 scene 1” scene and add the “Op1 scene 2” scene to the merge scene:

^AR Merge Scene,,Op1 scene 1,Op1 scene 2,1 ^B 51 ^W^C

To change the source that is applied to a certain window in a scene, two commands are sent:

^AR Op1 scene 2,0,New Source 1 ^B 52 ^W^C (applies “New Source 1” source to window “0” in the “Op1 scene 2” scene)

^AR Merge Scene,,Op1 scene 2,1 ^B 51 ^W^C (refreshes the merged scene)

To change the window style, use command 53 and refresh the merge scene:

^AR Op1 scene 2,0,Arial 1 ^B 53 ^W^C

^AR Merge Scene,,Op1 scene 2,1 ^B 51 ^W^C

To change the border text on a window, use command 54 and refresh the merge scene:

^AR Op1 scene 2,0,Camera 15 ^B 54 ^W^C

^AR Merge Scene,,Op1 scene 2,1 ^B 51 ^W^C

To change the overlay text on a window, use command 55 and refresh the merge scene:

^AR Op1 scene 2,0,Camera 15 ^B 55 ^W^C

^AR Merge Scene,,Op1 scene 2,1 ^B 51 ^W^C

To remove all of the windows from the merge scene, use the Purge scene command (56) and refresh the scene:

^AR ^B 56 ^W^C

^AR Merge Scene,,,1 ^B 51 ^W^C
# ASCII Character Chart

The ASCII character chart below is provided as a reference for creating your serial data strings.

<table>
<thead>
<tr>
<th>Dec</th>
<th>Hex</th>
<th>ASCII</th>
<th>CTRL Key</th>
<th>Dec</th>
<th>Hex</th>
<th>ASCII</th>
<th>Dec</th>
<th>Hex</th>
<th>ASCII</th>
<th>Dec</th>
<th>Hex</th>
<th>ASCII</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0x0</td>
<td>NULL</td>
<td>^@</td>
<td>32</td>
<td>0x20</td>
<td>&lt;SPACE&gt;</td>
<td>64</td>
<td>0x40</td>
<td>@</td>
<td>96</td>
<td>0x60</td>
<td>`</td>
</tr>
<tr>
<td>1</td>
<td>0x1</td>
<td>SOH</td>
<td>^A</td>
<td>33</td>
<td>0x21</td>
<td>!</td>
<td>65</td>
<td>0x41</td>
<td>A</td>
<td>97</td>
<td>0x61</td>
<td>a</td>
</tr>
<tr>
<td>2</td>
<td>0x2</td>
<td>STX</td>
<td>^B</td>
<td>34</td>
<td>0x22</td>
<td>“</td>
<td>66</td>
<td>0x42</td>
<td>B</td>
<td>98</td>
<td>0x62</td>
<td>b</td>
</tr>
<tr>
<td>3</td>
<td>0x3</td>
<td>ETX</td>
<td>^C</td>
<td>35</td>
<td>0x23</td>
<td>#</td>
<td>67</td>
<td>0x43</td>
<td>C</td>
<td>99</td>
<td>0x63</td>
<td>c</td>
</tr>
<tr>
<td>4</td>
<td>0x4</td>
<td>EOT</td>
<td>^D</td>
<td>36</td>
<td>0x24</td>
<td>$</td>
<td>68</td>
<td>0x44</td>
<td>D</td>
<td>100</td>
<td>0x64</td>
<td>d</td>
</tr>
<tr>
<td>5</td>
<td>0x5</td>
<td>ENQ</td>
<td>^E</td>
<td>37</td>
<td>0x25</td>
<td>%</td>
<td>69</td>
<td>0x45</td>
<td>E</td>
<td>101</td>
<td>0x65</td>
<td>e</td>
</tr>
<tr>
<td>6</td>
<td>0x6</td>
<td>ACK</td>
<td>^F</td>
<td>38</td>
<td>0x26</td>
<td>&amp;</td>
<td>70</td>
<td>0x46</td>
<td>F</td>
<td>102</td>
<td>0x66</td>
<td>f</td>
</tr>
<tr>
<td>7</td>
<td>0x7</td>
<td>BEL</td>
<td>^G</td>
<td>39</td>
<td>0x27</td>
<td>’</td>
<td>71</td>
<td>0x47</td>
<td>G</td>
<td>103</td>
<td>0x67</td>
<td>g</td>
</tr>
<tr>
<td>8</td>
<td>0x8</td>
<td>BS</td>
<td>^H</td>
<td>40</td>
<td>0x28</td>
<td>(</td>
<td>72</td>
<td>0x48</td>
<td>H</td>
<td>104</td>
<td>0x68</td>
<td>h</td>
</tr>
<tr>
<td>9</td>
<td>0x9</td>
<td>HT</td>
<td>^I</td>
<td>41</td>
<td>0x29</td>
<td>)</td>
<td>73</td>
<td>0x49</td>
<td>I</td>
<td>105</td>
<td>0x69</td>
<td>i</td>
</tr>
<tr>
<td>10</td>
<td>0xA</td>
<td>LF</td>
<td>^J</td>
<td>42</td>
<td>0x2A</td>
<td>*</td>
<td>74</td>
<td>0x4A</td>
<td>J</td>
<td>106</td>
<td>0x6A</td>
<td>j</td>
</tr>
<tr>
<td>11</td>
<td>0xB</td>
<td>VT</td>
<td>^K</td>
<td>43</td>
<td>0x2B</td>
<td>+</td>
<td>75</td>
<td>0x4B</td>
<td>K</td>
<td>107</td>
<td>0x6B</td>
<td>k</td>
</tr>
<tr>
<td>12</td>
<td>0xC</td>
<td>FF</td>
<td>^L</td>
<td>44</td>
<td>0x2C</td>
<td>,</td>
<td>76</td>
<td>0x4C</td>
<td>L</td>
<td>108</td>
<td>0x6C</td>
<td>l</td>
</tr>
<tr>
<td>13</td>
<td>0xD</td>
<td>CR</td>
<td>^M</td>
<td>45</td>
<td>0x2D</td>
<td>-</td>
<td>77</td>
<td>0x4D</td>
<td>M</td>
<td>109</td>
<td>0x6D</td>
<td>m</td>
</tr>
<tr>
<td>14</td>
<td>0xE</td>
<td>SO</td>
<td>^N</td>
<td>46</td>
<td>0x2E</td>
<td>.</td>
<td>78</td>
<td>0x4E</td>
<td>N</td>
<td>110</td>
<td>0x6E</td>
<td>n</td>
</tr>
<tr>
<td>15</td>
<td>0xF</td>
<td>SI</td>
<td>^O</td>
<td>47</td>
<td>0x2F</td>
<td>/</td>
<td>79</td>
<td>0x4F</td>
<td>O</td>
<td>111</td>
<td>0x6F</td>
<td>o</td>
</tr>
<tr>
<td>16</td>
<td>0x10</td>
<td>DLE</td>
<td>^P</td>
<td>48</td>
<td>0x30</td>
<td>0</td>
<td>80</td>
<td>0x50</td>
<td>P</td>
<td>112</td>
<td>0x70</td>
<td>p</td>
</tr>
<tr>
<td>17</td>
<td>0x11</td>
<td>DC1</td>
<td>^Q</td>
<td>49</td>
<td>0x31</td>
<td>1</td>
<td>81</td>
<td>0x51</td>
<td>Q</td>
<td>113</td>
<td>0x71</td>
<td>q</td>
</tr>
<tr>
<td>18</td>
<td>0x12</td>
<td>DC2</td>
<td>^R</td>
<td>50</td>
<td>0x32</td>
<td>2</td>
<td>82</td>
<td>0x52</td>
<td>R</td>
<td>114</td>
<td>0x72</td>
<td>r</td>
</tr>
<tr>
<td>19</td>
<td>0x13</td>
<td>DC3</td>
<td>^S</td>
<td>51</td>
<td>0x33</td>
<td>3</td>
<td>83</td>
<td>0x53</td>
<td>S</td>
<td>115</td>
<td>0x73</td>
<td>s</td>
</tr>
<tr>
<td>20</td>
<td>0x14</td>
<td>DC4</td>
<td>^T</td>
<td>52</td>
<td>0x34</td>
<td>4</td>
<td>84</td>
<td>0x54</td>
<td>T</td>
<td>116</td>
<td>0x74</td>
<td>t</td>
</tr>
<tr>
<td>21</td>
<td>0x15</td>
<td>NAK</td>
<td>^U</td>
<td>53</td>
<td>0x35</td>
<td>5</td>
<td>85</td>
<td>0x55</td>
<td>U</td>
<td>117</td>
<td>0x75</td>
<td>u</td>
</tr>
<tr>
<td>22</td>
<td>0x16</td>
<td>SYN</td>
<td>^V</td>
<td>54</td>
<td>0x36</td>
<td>6</td>
<td>86</td>
<td>0x56</td>
<td>V</td>
<td>118</td>
<td>0x76</td>
<td>v</td>
</tr>
<tr>
<td>23</td>
<td>0x17</td>
<td>ETB</td>
<td>^W</td>
<td>55</td>
<td>0x37</td>
<td>7</td>
<td>87</td>
<td>0x57</td>
<td>W</td>
<td>119</td>
<td>0x77</td>
<td>w</td>
</tr>
<tr>
<td>24</td>
<td>0x18</td>
<td>CAN</td>
<td>^X</td>
<td>56</td>
<td>0x38</td>
<td>8</td>
<td>88</td>
<td>0x58</td>
<td>X</td>
<td>120</td>
<td>0x78</td>
<td>x</td>
</tr>
<tr>
<td>25</td>
<td>0x19</td>
<td>EM</td>
<td>^Y</td>
<td>57</td>
<td>0x39</td>
<td>9</td>
<td>89</td>
<td>0x59</td>
<td>Y</td>
<td>121</td>
<td>0x79</td>
<td>y</td>
</tr>
<tr>
<td>26</td>
<td>0x1A</td>
<td>SUB</td>
<td>^Z</td>
<td>58</td>
<td>0x3A</td>
<td>:</td>
<td>90</td>
<td>0x5A</td>
<td>Z</td>
<td>122</td>
<td>0x7A</td>
<td>z</td>
</tr>
<tr>
<td>27</td>
<td>0x1B</td>
<td>ESC</td>
<td>^[</td>
<td>59</td>
<td>0x3B</td>
<td>;</td>
<td>91</td>
<td>0x5B</td>
<td>[</td>
<td>123</td>
<td>0x7B</td>
<td>{</td>
</tr>
<tr>
<td>28</td>
<td>0x1C</td>
<td>FS</td>
<td>^\</td>
<td>60</td>
<td>0x3C</td>
<td>&lt;</td>
<td>92</td>
<td>0x5C</td>
<td>\</td>
<td>124</td>
<td>0x7C</td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>0x1D</td>
<td>GS</td>
<td>^]</td>
<td>61</td>
<td>0x3D</td>
<td>=</td>
<td>93</td>
<td>0x5D</td>
<td>]</td>
<td>125</td>
<td>0x7D</td>
<td>}</td>
</tr>
<tr>
<td>30</td>
<td>0x1E</td>
<td>RS</td>
<td>^^</td>
<td>62</td>
<td>0x3E</td>
<td>&gt;</td>
<td>94</td>
<td>0x5E</td>
<td>^</td>
<td>126</td>
<td>0x7E</td>
<td>~</td>
</tr>
<tr>
<td>31</td>
<td>0x1F</td>
<td>US</td>
<td>^_</td>
<td>63</td>
<td>0x3F</td>
<td>?</td>
<td>95</td>
<td>0x5F</td>
<td>_</td>
<td>127</td>
<td>0x7F</td>
<td>&lt;DEL&gt;</td>
</tr>
</tbody>
</table>

---

Quantum Control Software • Serial Commands
Access Control

This section describes access control that is incorporated in the Quantum Control Software, allowing different operators to gain access to different tasks. Topics that are covered include:

- Login Procedure
- Enabling and Disabling Access Control
- Changing Role Passwords

Login Procedure

The Quantum Control Software incorporates an access control system that allows different operators to have access to different tasks according to their needs and responsibility. This feature helps to prevent end users from being able to accidentally or deliberately change the setup of the Quantum Control system.

The following table lists the three operator roles available along with the tasks that are accessible to each role.

<table>
<thead>
<tr>
<th>Task</th>
<th>Operator Role</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Administrator</td>
</tr>
<tr>
<td>Choose Display Processors</td>
<td>X</td>
</tr>
<tr>
<td>Choose Layout</td>
<td>X</td>
</tr>
<tr>
<td>Communications Setup</td>
<td>X</td>
</tr>
<tr>
<td>Set Up Sources</td>
<td>X</td>
</tr>
<tr>
<td>Scene Design</td>
<td>X</td>
</tr>
<tr>
<td>Scene Control</td>
<td>X</td>
</tr>
<tr>
<td>Remote Access Setup</td>
<td>X</td>
</tr>
</tbody>
</table>

**NOTE:** When you log in as a User, the Scene Control task opens in full screen mode (Run View only, not Design View). To return to normal screen mode (such as to adjust the brightness setting), press the <Esc> key on the keyboard. To return to full screen mode, click the **Scene Control** button on the taskbar.

With the access control feature enabled, a Login dialog box opens each time you start the Quantum Control Software (see figure 44).
To log in to the Quantum Control Software:

1. From the User drop-down list, select the desired role.
2. In the Password field, enter the required password for the chosen role.
3. Click OK or press the <Enter> key on the keyboard to continue. The Quantum Control Software splash screen appears for a few seconds, followed by the main application window (see “Main Application Window”).

**NOTES:**
- By default, the password for each operator role is the same as the user name. For example, for the User role, the password is User.
- Passwords are case-sensitive.

## Enabling and Disabling Access Control

Following a new installation of the Quantum Control Software, the access control system is disabled. Anyone using the application has access to all areas of functionality.

**NOTE:** Access control can be enabled by any user. However, after it has been enabled, it can only be disabled by an Administrator.

To enable access control:

- From the Access Control menu, select **Enable Access Control**. Access control is enabled the next time you close and restart the Quantum Control Software.

To disable access control:

1. Start the Quantum Control Software application and log in as an Administrator (see “Login Procedure”).
2. From the Access Control menu, select **Disable Access Control**. Access control is disabled the next time that the Quantum Control Software is closed and restarted.
Changing Role Passwords

By default, the password for each operator role is the same as the role name. For example, for the User role, the password is User.

**NOTE:** Passwords are case-sensitive. For example, if the password is User, entering user or USER is not recognized.

It is recommended that the default passwords are changed as soon as possible after installation. A password can contain any standard keyboard letters, numbers, or symbols and can be any length.

Passwords can only be changed by an Administrator, following the login procedure.

To change a role password:

1. Start the Quantum Control Software and log in as an Administrator.

3. From the Role drop-down list, select the appropriate operator role.
4. The current password for that role appears in the Password field. Change the password as needed.
5. Click OK to save the new password or click Cancel to retain the existing password. The new password takes effect the next time you close and restart the Quantum Control Software.
Appendix

This section discusses how to apply window styles to source windows on a Quantum display by modifying the XML file installed with the Quantum Control Software. This section also explains merge scene functionality and how to assign IP addresses for your devices. Topics that are covered include:

- Modifying Window Styles
- Working with Merge Scenes
- IP Addressing

Modifying Window Styles

Overview

The Quantum Control Software allows you to apply window styles to source windows on a Quantum display. Styles allow source windows to have the following features:

- Border of a specified color and width
- Title bar of a specified font, size, and color
- Text overlay of a specified font, size, and color

Title text displays on a solid background that is the same color as the border. Overlay text is text that is placed on top of the source image and does not have a background.

**NOTE:** Although a window can have both overlay text and title text at the same time, typically only one or the other is used.

 Styles are defined by an XML file that is installed on the PC hard disk when you install the Quantum Control Software. You can add new styles or modify existing styles by editing the XML file.

**NOTES:**
- If you reinstall the Quantum Control Software at any time, the XML file will be overwritten with the default version and any changes that you made will be lost. Always keep a backup copy of the XML file. The XML file is a separate file and is not part of the presentation (.ctp) file. Copying shows between different computers requires both files to be copied.
- After reinstalling the Quantum Control Software, always replace the default XML file with your customized XML file before starting the Quantum Control Software.
- Otherwise, if you start the application with a presentation file that refers to non-existent styles, the missing styles are removed from all affected windows. If the show file is saved at this point, it is saved without the required styles. If you reinstall the correct XML file at this point, you need to manually reapply the missing styles to each affected window in the presentation file.
Locating and Opening the XML File

You can edit the XML file using Microsoft Notepad or a proprietary XML editor if available.

To edit the file using Notepad:

1. From the desktop, click Start > All Programs > Accessories > Notepad. This opens the Notepad application.
2. From the File menu, select Open. The Open dialog box is displayed.
3. From the Files of type drop-down list, select All Files.
4. Browse to and select the XML file. By default, the file is located in the following folder on the computer hard disk:
   C:\Program Files\Extron\Quantum Elite\XML\ Quantum Source Types
   - or -
   C:\Program Files\Extron\Quantum Connect\XML\ Quantum Source Types
   The file is called ESQuantumConfig.xml.
5. Click Open.

The XML file looks similar to the following:

![Figure 46. ESQuantumConfig.xml File](image)

**NOTE:** Before you make any changes to this file, it is strongly recommended that you create a backup copy. From the File menu, select Save As to open the Save As dialog and save a backup copy.

**TIP:** To make the text easier to read in Notepad, it is recommended that you turn off the Wordwrap feature (via the Format menu).

In the file, scroll down to the `<WindowStyles>` (opening) tag. The lines of information between this tag and the `</WindowStyles>` (closing) tag define all of the styles that appear in the Quantum Control Software.
Overview of the Style Tag

Each style is defined with a separate `<Style>` tag. For example, the tag for the default style is defined by:

```xml
<Style Id="Default" Name="Default Style">
    <Title Show="1" Font="Verdana" Size="14" Bold="1" HorizPosition="Centre" VertPosition="Bottom" Colour="153,204,255" Flash="0"/>
    <Overlay Show="1" Font="Verdana" Size="14" Bold="1" HorizPosition="Left" VertPosition="Bottom" Colour="153,204,255" Flash="0"/>  
    <Border Show="0" Colour="51,51,51" Thickness="2" Flash="0"/>
</Style>
```

In the `<Style Id="Default" Name ="Default Style">` line of the example:

- **Name** is the name of the style as it will appear on the Window Styles tab of the Window Properties dialog box in the Quantum Control Software.
- **Id** is a short name or reference for the style and identifies the style in RS-232 control messages.

The `<Title>` tag defines the attributes of the title bar, including font style, size, and color:

```xml
    <Title Show="1" Font="Verdana" Size="14" Bold="1" HorizPosition="Centre" VertPosition="Bottom" Colour="153,204,255" Flash="0"/>
```

The `<Overlay>` tag defines the attributes of the border:

```xml
    <Overlay Show="1" Font="Verdana" Size="14" Bold="1" HorizPosition="Left" VertPosition="Bottom" Colour="153,204,255" Flash="0"/>
```

The `<Border>` tag defines the attributes of the border:

```xml
    <Border Show="0" Colour="51,51,51" Thickness="2" Flash="0"/>
```

The `</style>` tag is the closing tag.

Many of the attributes are common to each tag and are listed in the table in “Summary of style attributes.”
## Summary of style attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Function</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show</td>
<td>Sets the text or border as visible or hidden</td>
<td>● 0 = hidden</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● 1 = visible</td>
</tr>
<tr>
<td>Font</td>
<td>The font name chosen from the fonts that are installed on the Quantum processor</td>
<td>Default fonts are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Arial</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Verdana</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Microsoft Sans Serif</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Tahoma</td>
</tr>
<tr>
<td>Size</td>
<td>Sets the size of the font. The larger the number, the bigger the text.</td>
<td>Depends on display resolution and size. Typically, a value between 10 and 40 provides readable results.</td>
</tr>
<tr>
<td>Bold</td>
<td>Sets the font weight</td>
<td>● 0 = normal</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● 1 = bold</td>
</tr>
<tr>
<td>HorizPosition</td>
<td>Defines the horizontal alignment of the text</td>
<td>● Left</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Centre</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Right</td>
</tr>
<tr>
<td>VertPosition</td>
<td>Defines the vertical alignment of the text</td>
<td>● Top</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Centre</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Bottom</td>
</tr>
<tr>
<td>Thickness</td>
<td>Defines the width of the border</td>
<td>Width in pixels, typically between 1 and 10 are acceptable values.</td>
</tr>
<tr>
<td>Colour</td>
<td>Defines the color of the text or border using RGB colors</td>
<td>Values between 0 and 255:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● 0,0,0 = black</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● 255,255,255 = white</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● 255,0,0 = red</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● 0,255,0 = green</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● 0,0,255 = blue</td>
</tr>
<tr>
<td>Flash</td>
<td>Defines whether the text or border is static or flashing.</td>
<td>● 0 = static</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● 1 = flashing</td>
</tr>
</tbody>
</table>

**NOTE:** Center alignment is not applicable to title text.
Modifying an Existing Style

To modify an existing style:

1. Edit the appropriate attributes as needed.
   For example, to change the default style to use Arial font on the title bar with the text aligned to the left, change the attribute values shown in italics:

   `<Style Id="Default" Name="Default Style">
   <Title Show="1" Font="Arial" Size="14" Bold="1" HorizPosition="Left" VertPosition="Bottom" Colour="153,204,255" Flash="0"/>
   <Overlay Show="1" Font="Verdana" Size="14" Bold="1" HorizPosition="Left" VertPosition="Bottom" Colour="153,204,255" Flash="0"/>
   <Border Show="0" Colour="51,51,51" Thickness="2" Flash="0"/>
   </Style>`

2. From the File menu in Notepad, select Save to save any changes that you made.
3. Restart the Quantum Control Software to load the new style.

Adding a New Style

The easiest way to add a new style is to copy and paste an existing style, then modify it.

For example, to create a new style called My Style with the following attributes:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title Bar Text</td>
<td></td>
</tr>
<tr>
<td>Font</td>
<td>Tahoma</td>
</tr>
<tr>
<td>Size</td>
<td>12</td>
</tr>
<tr>
<td>Bold</td>
<td>No</td>
</tr>
<tr>
<td>Position</td>
<td>Top Right</td>
</tr>
<tr>
<td>Colour</td>
<td>Yellow (240,240,0)</td>
</tr>
<tr>
<td>Overlay Text</td>
<td></td>
</tr>
<tr>
<td>Font</td>
<td>Tahoma</td>
</tr>
<tr>
<td>Size</td>
<td>12</td>
</tr>
<tr>
<td>Bold</td>
<td>No</td>
</tr>
<tr>
<td>Position</td>
<td>Centre</td>
</tr>
<tr>
<td>Colour</td>
<td>Red (240,0,0)</td>
</tr>
<tr>
<td>Border</td>
<td></td>
</tr>
<tr>
<td>Width</td>
<td>3</td>
</tr>
<tr>
<td>Colour</td>
<td>Gray (128,128,128)</td>
</tr>
</tbody>
</table>
1. Select an existing style in the XML file.

**NOTE:** You must include the opening and closing Style tag.

![Figure 47. Selecting an Existing Style in the XML File](image)

2. Right-click the selected text and select **Copy** from the drop-down menu.

3. Paste the selected text between Style tags (after a </Style> tag and before the <Style> tag that follows it). To do so:
   a. Press the <Enter> key on your keyboard after a </Style> tag. This moves the cursor to a new line above the next <Style> tag.
   b. Press the <Tab> key on your keyboard to align the cursor with the previous </Style> tag.
   c. Right-click in the blank line and select **Paste** from the drop-down menu.

4. Modify the copied style to reflect the necessary attributes (see the table preceding these steps). The text for the new style appears as follows:

   ```xml
   <Style Id="MyStyle" Name="My Style">
   <Title Show="1" Font="Tahoma" Size="12" Bold="0"
   HorizPosition="Right" VertPosition="Top" Colour="240,240,0"
   Flash="0"/>
   <Overlay Show="1" Font="Tahoma" Size="12" Bold="0"
   HorizPosition="Centre" VertPosition="Centre" Colour="240,0,0"
   Flash="0"/>
   <Border Show="0" Colour="128,128,128" Thickness="3" Flash="0"/>
   </Style>
   ```

5. From the **File** menu in Notepad, select **Save** to save any changes that you made.

6. Restart the Quantum Control Software to load the new style.
Working with Merge Scenes

Merge Scene Overview

A merge scene allows sources on different areas of a display wall to be merged into the overall scene. The merge scene acts as a master scene while other scenes acts as subscenes. Each subscene is unique and is managed independently from one another. This is useful when dividing the pixel map into logical groups or display areas for independent control.

An overview of the merge scene workflow is:

1. Define the independent displays or display groups and allocate one or more subscenes for each.
2. Program and control the subscenes as needed.
3. Add or remove subscene data to or from the merge scene.
4. Refresh the merge scene. This is required in order for merge scene changes to take effect.

Defining Displays or Display Groups

To create a merge scene, define which displays or display groups are to be independently controlled.

In the following example, there are nine display groups:

- Display group 1 is a 2x4 videowall.
- Display group 2 through 9 are independent LCD panels.

In the following figure, the display groups are shown in white.

![Display Groups Diagram]

Figure 48. Display Groups
Programming Subscenes

After you define the display groups, create the subscenes that belong to each group. In the following examples, screen group 1 (see figure 48) has eight subscenes titled Videowall1 through Videowall8. Each subscene has a unique layout.

Figure 49. Videowall1 Subscene

Figure 50. Videowall2 Subscene
Screen group 2 has three subscenes, LCD1-1 through LCD1-3, allocated to it. Each subscene is programmed to have a unique layout as shown in the following examples.

**Figure 51. Videowall3 Subscene**

**Figure 52. LCD1-1 Subscene**
The remaining subscenes (subscene 3 through subscene 9), are allocated to the remaining LCD displays (LCD2 through LCD8). These subscenes follow the same convention as subscene 2 (LCD1).

**Workflow**

The merge scene should be the only scene that is running (active) in the Quantum Control Software. The merge scene is highlighted in the scene list to indicate that it is the currently active scene.

**NOTE:** All control commands are to be directed to a specific subscene, not to the merge scene.
The following example workflow uses the previous subscene examples.

1. Add a subscene to a merge scene. This essentially calls or runs the subscene.
   For example, add Videowall1 to Merge Scene:
   
   \[[01] \text{RMerge } \text{Scene}, ,\text{Videowall1}, 1 [02] 51 [17] [03]\]

2. Make the desired changes to a subscene.
   For example, set Videowall1/Window1 to SourceRGB1:
   
   \[[01] \text{RVideowall1}, 0, \text{RGB1} [02] 52 [17] [03]\]

3. Update the merge scene with the changed information from step 2, above.
   
   \textbf{NOTE:} This step is required in order for changes to take effect.
   
   For example, the following adds Videowall1 to the merge scene and applies updated subscene information:
   
   \[[01] \text{RMerge } \text{Scene}, ,\text{Videowall1}, 1 [02] 51 [17] [03]\]

4. Change one scene to the next scene.
   For example, remove Videowall1 and add Videowall2:
   
   \[[01] \text{RMerge } \text{Scene}, \text{Videowall1}, \text{Videowall2}, 1 [02] 51 [17] [03]\]

The window index numbers in the merge scene increment dynamically. The window index numbers in the subscene are left unchanged.

When making several changes to a subscene, it may be more efficient to wait until all of the changes have been made before executing a final refresh of the merge scene.

For example:

Videowall1/Window1 set to SourceRGB1
Videowall1/Window2 set to SourceRGB2
Videowall1/Window3 set to SourceRGB3

\[[01] \text{RVideowall1}, 0, \text{RGB1} [02] 52 [17] [03]\]
\[[01] \text{RVideowall1}, 1, \text{RGB3} [02] 52 [17] [03]\]
\[[01] \text{RVideowall1}, 3, \text{RGB3} [02] 52 [17] [03]\]
\[[01] \text{RMerge } \text{Scene}, ,\text{Videowall1}, 0 [02] 51 [17] [03]\]
\[[01] \text{RMerge } \text{Scene}, ,1 [02] 51 [17] [03]\]

It may be beneficial to write a subroutine that will track which subscene is currently running when changing scenes. The subroutine indicates the subscene that needs to be removed from the merge scene before the next subscene can be added.

### IP Addressing

#### What is an IP Address?

A full explanation of IP addressing is beyond the scope of this user guide. However, the following details provide enough information to get started.

An IP address is a 32-bit binary number that is used to identify each device on an Ethernet network. This number is usually represented by four decimal numbers (each in the range of 0 to 255) separated by dots, such as 198.123.34.240. This is called “dotted decimal notation.”
An IP address is divided into two parts:

- Network identifier
- Host identifier

Each address on a given network must have the same network identifier value but have a unique host identifier. As a result, there are different classes of addresses that define the range of valid addresses and which parts of the address are used for the network and host identifiers.

The most common IP address classes are:

<table>
<thead>
<tr>
<th>Class Name</th>
<th>Valid Address Range</th>
<th>Identifier Arrangement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class A</td>
<td>0.0.0.1 to 127.255.255.254</td>
<td>NNN. HHH. HHH. HHH</td>
</tr>
<tr>
<td>Class B</td>
<td>128.0.0.1 to 191.255.255.254</td>
<td>NNN. NNN. HHH. HHH</td>
</tr>
<tr>
<td>Class C</td>
<td>192.0.0.1 to 223.255.255.254</td>
<td>NNN. NNN. NNN. HHH</td>
</tr>
</tbody>
</table>

**Choosing IP Addresses**

If the Quantum Control Software computer and Quantum processors are directly connected or connected via their own independent network, follow the guidelines below for choosing the IP addresses.

However, if you intend to connect your computer and Quantum processors to an existing network, you need to advise the network administrator and ask the administrator to allocate suitable IP addresses.

On an independent network, it is generally recommended that you use the Class C format (from 192.0.0.1 to 223.255.255.254).

There are two rules for choosing IP addresses:

- Network identifier must be the same for each IP address
- Host identifier must be unique for each address.

Applying these rules to Class C addresses, the first three decimal values of your IP address must all be the same while the last value is used to uniquely identify each device.

The following is an example of a valid Class C addressing scheme:

<table>
<thead>
<tr>
<th>Device</th>
<th>IP Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantum Control Software Computer</td>
<td>208.132.180.41</td>
</tr>
<tr>
<td>Quantum processor 1</td>
<td>208.132.180.42</td>
</tr>
<tr>
<td>Quantum processor 2</td>
<td>208.132.180.43</td>
</tr>
</tbody>
</table>

**NOTE:** The host identifiers (41, 42, and 43 in the above example) do not need to be sequential or in any particular order. However, it is recommended that you group the numbers for simplicity.
The following is an example of an invalid Class C addressing scheme:

<table>
<thead>
<tr>
<th>Device</th>
<th>IP Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantum Control Software Computer</td>
<td>208.132.180.41</td>
</tr>
<tr>
<td>Quantum processor 1</td>
<td>192.157.180.42</td>
</tr>
<tr>
<td>Quantum processor 2</td>
<td>209.100.123.43</td>
</tr>
</tbody>
</table>

**NOTE:** The above addresses are invalid because the network identifier for each address is not the same even though each IP address is unique.

You can perform a test from your computer to check that a device at a particular address is responding correctly (see “Testing the Ethernet link”).

**Subnet mask**

The subnet mask is another 32-bit binary number that is used to “mask” certain bits of the IP address. This provides a method of extending the number of network options for a given IP address. It works by allowing part of the host identifier to be used as a subnet identifier.

It is important that you set the correct value for the subnet mask. The basic values depend on the class of IP address being used.

<table>
<thead>
<tr>
<th>Class Name</th>
<th>Subnet Mask</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class A</td>
<td>255.0.0.0</td>
</tr>
<tr>
<td>Class B</td>
<td>255.255.0.0</td>
</tr>
<tr>
<td>Class C</td>
<td>255.255.255.0</td>
</tr>
</tbody>
</table>